Chapter 1 Introduction to InSpec Page 1 of 3

Chapter 1 Introduction to InSpec

Micro-Vu’s InSpec metrology software provides powerful, on-screen measuring functions reaching
well beyond the realm of a measuring digital readout. Integrating the software with video measuring

stages and motion control, Micro-Vu has created truly powerful Measuring Centers .

A Micro-Vu Measuring Center'" includes the following items:

« InSpec Metrology Software.

« Precision measuring stage.

¢ Motion control electronics.

« High-resolution CCD camera and image processing circuit board.
« Programmable profile, axial, and surface lighting.

What is InSpec for Windows?

InSpec Metrology Software is a measuring application for vision measuring machines. Itis an
extremely powerful metrology tool, yet was designed to be easy to use and program. If you are
familiar with other Windows applications, such as Word or Excel, you should find InSpec familiar and
intuitive.

InSpec supports many types of geometric features and operations. A feature may be an edge,
height, hole, radius, or one of many other geometric characteristics on a part. When a feature is
measured, InSpec calculates the position, size, and form of the feature.

InSpec is easy to program. InSpec uses a "teach" style programming where a program is
automatically written for you as you measure a part. These programs can be saved onto the
computer hard drive or floppy disk. Programs can be opened and rerun later. With DXF, IGES,
Gerber, and Excellon files, you can import features into InSpec and create programs even faster.

InSpec records measurements automatically. After measuring a part, you can browse through the
measurement data and video tools used to capture the data. You can compute distances and
construct new features from measured features. The data can be saved and used in spreadsheets
or Statistical Process Control (SPC) software to track production trends.

InSpec measures features using a few or many data points. A minimum number of data points are
required for each type of feature based on geometry. For example, a line requires a minimum of two
points. Itis simple to use additional points if desired. Just press the “more points” icon and enter
additional points. Using additional points will yield greater accuracy and repeatability.

InSpec lets you construct features by bisecting, intersecting, or using the center locations of other
features in a program. New features can be constructed from existing ones. When constructions
have more than one solution, a construction dialog will appear to help you select the correct
construction. With a line intersecting a circle there are two intersection points. InSpec would
automatically display a dialog to help you select the correct point.

Easily set and align to datum features. Alignment functions include level, skew, and set origin.
Leveling, skewing, and setting the origin define what is known as the part coordinate system. InSpec
supports multiple coordinate systems giving the user the flexibility to set several zero points,
alignments, or datum features in a single part program. In digital readout (DRO) terminology, this is
analogous to having several absolute and incremental datum features on one part.

Add on-screen instructions for users. InSpec offers user prompts. Messages can be entered and will
be displayed when a part is measured. Use the prompts to guide the user through the program or to
request data from the user, such as the lot number, date, or operator ID number.

The Measuring Machine
The stage is a precision electromechanical assembly that sends precise X, Y, and Z position data to
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the measuring software. When the stage is moved, linear encoders output the incremental
displacement to the computer.

Three-Axis Measuring: The part to be measured is placed or fixtured on the measuring stage and
viewed by the camera from above. The measuring stage (or the camera above on some systems)
moves so that the desired area of the part is in the camera view. Left to right motion is called the X-
axis. Similarly, motion front to back is called the Y-axis. The camera moves up and down in the
vertical, or Z-axis, in order to measure heights and to focus on the part. Because measurements can
be taken in the X, Y, and Z-axes, we call this type of system a three-axis measuring machine.

Stage Movement: The stage and camera are moved using a joystick or the on-screen mouse control
in the Camera Window. In general, for the X and Y-axes, pushing the joystick in a certain direction
will move the part's image in the same direction on the video monitor. These directions can be
reversed on some systems. The speed at which the stage moves is proportional to the deflection
from center. If the joystick is pushed slightly, the stage will move slowly. There is no need to tap the
joystick to jog slight amounts. For faster movement, press the “Rapid” button or the trigger button on
Qubix / Quantum systems.

To control the camera or Z position, press and hold the top button on the joystick and move the
joystick in the Y-axis direction. On systems with a Z button, press and hold the Z button and move
the joystick in the Y-axis direction.

When controlling the stage using the mouse, simply click on the Stage Controller icon and drag in the
direction you want to move. The speed will increase as you drag further and further from the icon.

Vision Components

The vision components consist of a camera, frame grabber, and a set of software tools to find feature
edges. Together they take care of looking at the part, capturing the image, and computing the edge
location.

By combining a measuring stage with the vision components, parts can be measured accurately and
automatically. This powerful yet easy-to-use system gives you automatic detection of edges,
motorized part positioning, and sophisticated geometric measuring capability. A Micro-Vu Measuring

Center™ complements any quality control area by adding sophisticated non-contact coordinate
measurement capabilities.

Key Features of Automated Vision

« Significantly improve inspection repeatability by eliminating operator subjectivity.
e Measure parts to sub-pixel accuracy.

« View large and small features with adjustable magnification.

« Automatically find edges of features on the surface of a part.

o Automatically determine profile edges on the part.

« Measure in the Z (vertical) axis by automatically focusing on the part.

« Enhance desired edges with programmable lighting.

« Position the motorized stage using the joystick or mouse.

« Intuitively create a part program as you measure a part the first time.

e Save and load part programs for an unlimited number of parts.

» Print reports of all measurements along with a diagram of the measured part.

« Export data to spreadsheets, SPC, or reports.

Starting Up Your Measuring Center "
After the system has been properly installed, you will be able to run InSpec and take measurements.
Turn on the computer.
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Notify all users that the computer should be turned on before the machine.

Turn on the machine.

The computer should already be powered up.

Remove from the stage parts that may interfere with the stage volume initialization.
Double-click on the InSpec icon on the Desktop to open InSpec.

Avoid using the zoom or joystick until after InSpec has completed the start up sequence.

If the Emergency Stop Switch is engaged when InSpec is started, a dialog box may indicate that the
machine is halted. Disengage the Emergency Stop switch and click Recover and Continue.

NOTE FOR QUBIX AND QUANTUM MACHINES: Always turn the lower chassis off before
shutting down Windows and turning off the computer. The lower chassis should not be on,
unless the computer is on.

Shutting Down Your Measuring Center"

The machines are designed to run without interruption. Start with software when you are shutting
down the system.

« Save your program if necessary.
e Close InSpec
e Turn off the machine.

¢  Shut down Windows and then the computer.

Technical Support

If you have questions that are not answered in this manual, you should contact your local Micro-Vu
Dealer. Your Micro-Vu Dealer is not only well versed with InSpec for Windows, but your local dealer
may be familiar with your application and be able to solve your problem quickly.

You may also contact Micro-Vu directly for technical support.

PHONE: 707.838.6272

FAX: 707.838.3985

EMAIL: support@microvu.com

Regardless of whom you contact, you need to have the following information ready:
Machine type, size, and serial number
Software version and operating system
Detailed information on the problem that you are experiencing
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Chapter 2 InSpec’s User Interface

Combined with a number of pop-up windows and pull down menus, the layout provides an easy-to-
understand yet powerful interface. This chapter will discuss four of the five sections of the interface.
The Program section is discussed in the following chapter.

1. The Schematic Window displays a graphic representation of the part.

2. The Results section displays information about the current feature or a log of all measured
features.

w

. The Status Section displays the current stage position, units, and lighting settings.

I

. The Camera Window displays the video image and vision tools and optional touch probe
functions.

S}

. The Program Interface displays the current program list with the feature, construction, and tool
icons.
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Schematic Window

InSpec draws a diagram of the programmed features in the top left section of the screen. Right
click options and colors simplify identification and selection of features.

Within the schematic window you can use the mouse to select single or multiple features. Use
Windows conventions such as holding the Control key down to select multiple features and click
and drag to select features within a selection area.

Colors are used to help the user distinguish selected and toleranced features. Features are
normally drawn using thin green lines. Thick green lines designate the “selected” feature(s).
Magenta indicates that the mouse is currently hovering over the feature. Red indicates that the
feature is incomplete or out of tolerance. Features that have playback disabled will appear light

gray.
Current Stage Position

Thin gray crosshairs indicate the current stage position relative to the displayed part. When you run
a program, a second set of crosshairs is displayed showing the position of the next feature. This is
especially helpful at the beginning of a program or when measuring manual points.
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Schematic Views

InSpec offers five standard views of the part schematic. Operators can choose between the
isometric, XZ, YZ, XY, and PCS views.

(7

The perspective view rotates the schematic for a view from above the front right corner of the stage.

The XZ, YZ, and XY views are relative to the machine coordinate system (MCS). As the icons
depict, these show the front, right, and top view of the part as it lays on the stage. For example, the
top view will show a tilted schematic of the part if the part is not aligned to the stage axis.

The part coordinate system (PCS) view shows the schematic relative to current coordinate system,
which is the system of the current feature. Program may have many different origins, skews, and
levels.

Schematic Zoom

Customers use Micro-Vu systems to measure a variety of parts. Some larger parts have small
features. InSpec provides zoom capabilities in the schematic so that you can view the relative
position of these features.

Use the Fit, Zoom-In, and Zoom-Out icons directly below the schematic window to zoom in on
smaller features and zoom out to see the entire schematic. When the schematic is in the “Zoom”
state, a center click on the mouse wheel will allow the user to pan the schematic view. Another
mouse click (left, right, or center) will exit the “Pan” mode.

E Use the Zoom-In icon toggles between the “Zoom” state and the “Pick” state. When the
button is pressed, the mouse cursor will show a magnifying glass when the mouse is in the
schematic window. To zoom in on features, click-and-drag a window around the area you would
like to enlarge.

When the button is “up”, the mouse cursor will be an arrow allowing the user to select features.

Q

—_1The Zoom-Out icon incrementally decreases the zoom so that you can make slight increases
to the field of view.

2 The Zoom-to-Fit icon will change the schematic zoom to display all of the features in the
program and the location of the current stage position. Note that if the camera location is not near
the part and the part is relatively small, then the part features will appear small on the screen.

(| The Tags icon allows the user to mark selected features on the schematic. This makes it
easier for the user to locate specific features. A feature’s Tag displays the number or name of the
feature. The user may select a group of features from the Features list and change the tag status
for all of the selected features at one time. When a feature is renamed the feature’s name is
displayed in place of its number.

Results Summary

InSpec displays measurement data by feature and as a summary of all features. The Feature View,
Points View, and Log View are displayed at the top center of the screen. Use tabs at the top of the
display to switch between the three views.

Feature View
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InSpec displays the name, system, measured values, and condition of tolerances for the current
feature in the Feature View. Green check marks, red Xs, and yellow rulers indicate the status of the
feature. A feature may be in tolerance or out of tolerance, or there may be a problem with a tool or
with the measurement. Smaller green checks and red Xs will appear next to feature characteristics
that are toleranced indicating that the individual characteristics are in or out of tolerance. The
summary updates immediately when another feature is selected. The arrow on the right side of the
Features List indicates which is the current feature.
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Many feature types have ten or more characteristics that may be displayed, toleranced, and
exported. You can choose which characteristics are displayed for each feature type. Select
Configure Summary from the Tools menu to customize the display of feature characteristics.

Points View

When most features are measured in InSpec, the data points are used to create a feature with
perfect geometry. The deviation of each of the individual data points from the perfect geometry of
the feature is called its residual to the fit.

The Points View shows a graphical depiction of the residuals of all the data points of a feature. The
errors can be exaggerated between 1x and 1000x by moving the slider bar along the top of the
dialog. By hovering over any point in the Points View, its residual will be displayed. If you right click
on a single point, there is a Move To Point option which will center the camera window on that
particular point.
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Some features, such as splines, go through each individual data point. These features have no
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residuals to show in the Points View.

Log View

The Log View summarizes the results of a program. There are three buttons on the Log View
display, In Tolerance, Out of Tolerance, and Failed to Measure. Selecting and un-selecting these
will customize the output in the Log View. Commonly, all the buttons are selected, or the Out of
Tolerance and Failed to Measure are selected together.

When you click on a feature in the log view, it will become the active feature in the program list.
When you hover with the mouse over a feature in the log view a tool tip will be displayed. The tool
tip will include the feature summary characteristics and values. Characteristics that have been
selected for export will be displayed to the right of the feature name.
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If you right click on a feature in the Log View, it bring up the Feature Context Menu. The Feature
Context Menu lets you remeasure or edit the properties of a feature or a group of features. For
more details of the Feature Context Menu, please refer to Chapter 3.

In Tolerance

Features that are in tolerance will be displayed with a green check mark next them. Individual
tolerances are listed below the feature.

Features without any tolerances are considered In Tolerance and will also be displayed. If any
characteristics of the feature have been selected for export, the values will appear after the feature
name.

Out of Tolerance

Features that are Out of Tolerance will be displayed with a red X. A feature is considered Out of
Tolerance if it has any characteristics that are out of tolerance. The actual and the deviation from
tolerance values will be displayed below the feature name.

Failed to Measure

Features that fail to measure will be displayed with a yellow and red ruler. If a tool fails in a feature,
the feature cannot be measured, and hence, tolerances cannot be evaluated. InSpec will list the
failed tools in the log view. When you click on a failed tool, InSpec will display the tool snapshot.
The operator can now adjust the tool as needed for the tool to succeed.
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Lighting Control

The lighting is completely programmable. The intensity of each light calibration "channel" is saved
to the program on an image-by-image basis. Each tool of each feature can have separate settings.
The lights can be calibrated for each machine so that the light intensity of one machine can be
duplicated on another machine — this allows for program swapping between machines.

If you are using 1280x1024 display resolution, the Lighting Control dialog will “dock” under the
DRO. If you are using a lower display resolution, then the light bulb icon in the top left corner of the
camera window is used to display and hide the Lighting Control dialog.

To change the lighting, select the surface, coaxial, or profile light by clicking on the appropriate
area of the lighting dialog. Then adjust to the desired level using the slide on the right. After the
first change in lighting, subsequent adjustments can be made with the center mouse wheel.

The surface light is produced with a ring of LEDs around the lens. The surface light can be
controlled as one unit, by rings, octants or quadrants, or by individual sectors. Buttons at the
bottom of the lighting display allow you to change between these settings. The slider on the right
adjusts intensity of the selected channel. You may select a group of sectors by clicking on the
sector and holding the Ctrl key or by click-and-dragging over the sectors.

Depending on the system, the surface light may have 1, 2 or 5 rings and 4, 16 or 40 programmable
sectors respectively. Below are examples of the display for the Macro Light Ring.
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The profile light originates below the part. It is the best light to use on through holes and the
edges of parts. Using the profile light alone creates a black and white image with sharp, high
contrast edges. Use the least amount of light needed to make the part appear black and the open
area light gray. Using excessive amounts of light will make the light “bleed” over the edges. Holes
and internal features will appear and measure larger and outer features and distances will appear
and measure smaller.

The coaxial light originates at the side of the zoom lens, reflects off a split mirror in the zoom lens,
and beams straight down on the part through the center of the lens. Axial light is useful at high
magnification or for looking in blind holes and at features on flat surfaces.

Lights Off and Auto Lights icons are found in the lower right corner of the lighting dialog. These
Auto Lights functions will set the selected lighting segments based on the image intensity and
composition. The light setting will be appropriate for many but not necessarily all applications.

Lighting Tips
Before you begin a new part measurement program, take some time to play with the lighting. Using
well-illuminated edges will make a more reliable inspection program.

Using the 2X adapter shortens the working distance of the lens. This requires a 2X light ring
because the it will be closer to the part. A 2X light ring appears brighter with lighting angles closer
to horizontal that help enhance difficult edges and chamfers. Conversely, without the 2X, the
working distance is longer; lighting appear slightly dimmer, and lighting angles are closer to vertical.

On reflective parts, turning off one or more of the quadrants of the ring light can often significantly
reduce glare. For example, on a shiny horizontal edge, turning off the front and rear sections can
often clean up the image.

For deep edges (like the sidewall of a part), it is sometimes useful to turn up the quadrant opposite
the higher edge. This sometimes reflects light off the deeper section and sharpens up the edge.

For illuminating deep holes, many times the only lighting option is the axial or "through-the-lens"
light. This will usually provide enough light to focus on the bottom of the hole to measure the depth
of the hole.

For profile edges, it is usually better to turn off the surface and axial lights so that any glare and
reflections from the part do not interfere with the edge detection.

Beware of ambient light. Being near a window or having lights directly above the machine will
reduce the effectiveness of the programmable lighting.

The Status Section

The top right section of the InSpec screen is dedicated to status settings, including position, units,
and lighting.

The digital readout (DRO) appears in the top-right corner of the screen. This counter shows the X-
Y-Z position or R-Theta-Z position of the crosshairs. The icons below the DRO allow the user to
move the stage and specify the units of measurement.

Displayed Units

The buttons below the DRO allow the user to specify the units and type of coordinate system. Units
can be selected and saved with each program.

The first pair toggles the system between X-Y-Z and R-Theta-Z formats, Cartesian and Polar
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formats. The next pair set the linear units, inches or millimeters. The next pair of buttons toggles
angular values between decimal and degrees:minutes:seconds. The last two buttons toggle the
temperature units.

The Camera Window

The camera window contains an actual image of your part. It may display live video or snapshots
depending on whether you are teaching or running a program. InSpec will display a diagram of the
selected touch probe when the optional touch probe is in use. Use the icons along the top of the
window to position the part view.

Stage Control

Although a joystick is provided, the stage can be completely controlled from the mouse and
keyboard. The X-Y movement is controlled with the icon on the four-directional icon. The Z
movement is controlled with the two-directional icon. When you click and drag on one of the icons
the stage will begin to move. The further the mouse is dragged the faster the movement.

It is recommended that you start slow and do not drag more than an inch from the icon until you
become familiar with the control. Move slowly around parts and prevent contact between the
camera and lighting and your parts and fixtures. Be especially careful when lowering the Z-axis.

uto Focus

This icon can be used to bring the image into focus. After getting the image roughly into focus
(using the Z-axis control), click on the icon. The system will move in Z and focus on the part.

Higher magnifications will produce sharper, more repeatable focus. This is in part due to the fact
that InSpec looks at the portion of the image inside the blue box at the center of the crosshairs. The
pixel size of the box remains fixed. Low magnification effectively increases the area used to focus,
and high magnification effectively uses a smaller area to focus. The larger area viewed at low
magnification will encompass more Z variation of the surface. Hence, the focus data creates a
wider bell curve with a less repeatable result.

Focus is based on the contrast of the image. Parts such as the chrome on glass screen calibration
target are considered ideal with a little profile light. You will usually find that even on black, white,
and uniformly gray parts, there is more than enough contrast to use the auto focus and the focus
point tool.

Click with the left mouse button on the icon to initiate the automatic focus search.
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4% |=
IChange Zoom
Use this list box to select the zoom stop and zoom in and out on a part.

The values displayed are the on-screen magnification values. The magnification displayed is
determined by the screen-calibration and the resolution and size of the monitor.

Click on the down-arrow to display a list of zoom stops. Select a zoom stop with the mouse, and
the zoom will then adjust to the new value. After the first zoom change, subsequent adjustments
can be made with the center wheel on the mouse.

The magnification is recorded with each vision tool when programming a part. When a program
runs, the zoom lens repeats the settings that were taught.

Digital Zoom

Depending on the type of machine, some of the highest zoom settings on your system may be
digital zoom. Digital zoom is done via software (as opposed to moving lenses) and therefore
happens instantaneously. If you change zoom setting and do not have to wait for the zoom motor to
come to position, then you are changing between 2 digital zoom settings.

Digital zoom uses the camera image from the highest optical zoom setting, and enlarges a portion
of that image to fill the camera window. It is useful for precisely placing vision tools on small
features. It has been used to accurately measure 10 micron gaps and circles.

Digital zoom will add 3x magnification to your system. Therefore a 12x optical system becomes a
36x system and a 6.5x system becomes a 19.5x system. It does not, however, add optical
resolution to the system.

Camera Window Context Menu

A right-click with the mouse in the camera window will display the Camera Context Menu.

Move Here

Short moves can be difficult to make, especially at high magnification. The “Move Here” function
makes small moves very easy. After you right-click on a feature in the camera window and choose
“Move To” InSpec will move the stage to center the image on the location that you clicked.

Place the mouse cursor on a feature in the camera window.
Right-click and select Move Here.

The Move Here feature is also a good way to test the Optics Calibration. If the selected feature is
off center after the move, it may indicate that the screen calibration is incorrect. When you add or
remove a 2x adapter without re-calibration of the optics, Move Here will overshoot or undershoot the
selected feature. If the Move Here does not seem to reach the desired location, run the Optics
Calibration under the Tools menu or consult your Micro-Vu distributor.

Move To...
Clicking on the Move to... option will bring up the following dialog box:
T ™ Meve Relative
: ¥ I+ e Absokite
| &
[
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In the Move to Coordinates pop-up window, the user can toggle between Move Relative and Move
Absolute. The moves will use the units shown below the DRO.

Choosing Move Relative will move the stage the specified X, Y, & Z distances relative to the current
stage position.

Choosing Move Absolute will move to the specified X-Y-Z coordinates with respect to the origin of
the current coordinate system.

Enter the X, Y, Z (and W, if applicable) off-set distances or coordinates. The W axis is only
displayed on systems equipped with the optional RSD-60 Rotary Indexer.

Before clicking “OK,” check for possible collisions. The system will make a straight line move from
the current position.

Show Crosshairs

The blue crosshairs can be displayed or hidden. A check next to Show Crosshairs indicates that
the crosshairs are currently visible. Toggle between visible and hidden by selecting Show
Crosshairs from the menu.

Save Snapshot

Save Snapshot captures the video image in the Camera Window to a file in BMP or JPG format.
The image can be saved with or without the Vision Tool and crosshairs by checking or un-checking
the Show Tool check box.

To save an image, right click on the video image in the Camera Window. From the listed options,
select Save Snapshot. Select the file type (BMP or JPG) from the bottom of the Save As window,
and select the directory and file name.

The entire InSpec interface can be captured using the PrintScrn key. The Camera Window will be
blank because of the live video display. If you need the interface and the camera window together,
you can overlay them in most drawing programs.
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Chapter 3 The Program Interface

Information about your part program is displayed in the lower left corner of the screen. The features
and inputs are listed on the left with the programming icons just to the right. This view will vary in
appearance depending on monitor resolution.

Features List

The Features list displays a list of the features in the program. Features are added to the list as you
create them the first time. When a program is run, features will be measured in the order that the
features appear in the list.
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A feature is usually some entity on a part that can be measured. InSpec can measure several types
of features including arcs, angles, circles, distances, ellipses, lines, o-rings, and points. Features
are measured from data points, field of view tools, or constructed from other features. There are
also text, prompt, command line, part separators, and temperature features.

A triangle on the right of the Features list indicates which is the “current feature.”
The “current selection” of features is highlighted.

Multiple features can be selected using the SHIFT and CTRL keys. Operations, such as deleting,
setting tolerances, or copying, are applied to the current selection of features.

Features Context Menu
Right clicking on a feature in the Features list will bring up the following menu:

Remessire

Eparts.. Fs

Toleranoes... F3

Salact Al Chrl+4

[relate Dred

Rename F2

Trarslabe. .,

Ratata. ..

Sl System,.,

Share .
BT ¢

Sak Crive Point Chrl+D .ﬂ

Sat. Lights[Zoom

irsert Here e

Irsert &t End Chrl+Ins

This menu provides the following functions:
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Remeasure — Recapture data for the selected feature(s).

Exports — Open an Exports dialog box to select export characteristics.
Tolerances... — Open a Tolerance dialog to set tolerance values for the selected feature(s).
Select All — Select all features in the program.

Delete — Delete the selected feature(s).

Rename ... — Change the name of the current feature.

Translate ... — Copy or Move selected feature(s) in X, Y, and Z.

Rotate... — Copy or Move selected feature(s) around the system origin.
Mirror... — Copy or Move selected feature(s) across the X or Y-axis.

Set System — Relate selected feature(s) to a different coordinate system.
Store... — Name and Save a feature for use in other programs.

Edit Solution... - Change some geometric constructions.

Edit Text... - Change the content of a Text feature.

Playback... - By enabling or disabling a feature, you can control whether it is measured the
next time the program is run.

Set/Clear Drive Point - Control the center location for capturing an image.

Set Zoom/Lights — Changes the zoom and light settings for all selected features to the
currently displayed zoom and lights settings.

Insert Here — Place the insertion bar in front of the current feature.
Insert at End — Place the insertion bar after the last feature.

Remeasure

This command is useful to test a tool on an edge or verify that the position of a translated feature is
correct without rerunning the entire program. If the feature precedes the first X-Y origin, the user
will be prompted to manually remeasure. If the feature follows the first system, InSpec will move to
and measure the feature automatically.

Exports

InSpec allows you to select individual characteristics of each feature to be exported to a data file.
You can select a single feature or a group of features when setting the characteristics to be
exported.

The export dialog box is a “pin up” box that remains on the screen as you select other features and
set exports. Use the “X” in the top right to close the dialog.
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To open the Feature Exports dialog box, first select the desired features in either the schematic or

the Features list. Right click on the features and select Exports from the context menu. The F4 hot
key will also open up the Feature Exports dialog.

Check the boxes for the properties and options you want to use. When your selection includes
multiple feature types, use the “Feature Type” drop down menu in the top left to select one feature
type at a time.

Export with Labels — This toggle allows the user to include labels with the exported data, such
as “Circle 10: Diameter.”

Export Nominals and Tolerances — This toggle will include tolerance values if available, for
each of the selected properties.

Property — These check boxes allow the user to specify which characteristics of the selected
features are to be exported.

Label — InSpec allows you to customize labels for exported data. If Export with Labels is
checked, InSpec will include a label with the export data. If no label is entered, then a default label
is created using the feature name and property. The label is in quotes to facilitate use in
spreadsheet and SPC software, i.e. “Circle 1: Center X".

Tolerances

InSpec has the ability to tolerance linear, angular, form, and positional dimensions. Tolerances can
be applied to a single feature or to multiple features.

For a single feature, the tolerance dialog box will display the available tolerances for the selected
feature type, as well as nominal values and calculated deviations from tolerance.

For multiple features, the dialog will only display the available tolerances for the selected feature
type. Nominal values will typically have question marks (???) indicating that the values for the the
features are different. If a number appears in the nominal column, then all of the features have the
same value, for example Z=0.
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The tolerance dialog box is a “pin-up” box that remains on the screen as you select other features
and set tolerances. Access the tolerance window through the Features Context Menu or by using
the F3 hot key.

Select All

This option can be used to pick all of the features in a program. You may want to use this so that
you can immediately tolerance features or delete all features to start a new program.

Delete

This is one of the most used features. When programming, you often find a better way to measure
a feature or change you mind after selecting a feature type. When you use “delete,” InSpec
assumes that you mean it and does not ask for confirmation.

Rename

InSpec automatically names features with a number. The name can be changed to an
alphanumeric phrase of up to 32 characters. The name is used in the program, summary, reports,
and tags. No two features in the same program can have the same name. A dialog box will appear
and allow you to enter your own name for the feature. The hot key for the rename dialog box is F2.

Eratiom 8

T

Translate

The Translate function allows the user to apply a transformation to a feature or a group of features.
First select the group of features and then select Translate from the Features Context Menu.
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At the top of the Translate menu box, first select the reference system for the translation. The
reference system will default to the parent system used by the feature directly above the 'Insert
Here' line. The default reference system will not be appropriate for every case.

By checking the Append copy number to feature names box InSpec will add _# to the end of each
feature name (including the source feature). For example, when feature Diameter is translated two
times along the X axis the result is Diameter_1, Diameter_2, and Diameter_3:

[ 48 Bttt 3 M Tl 5 T

®
>

And if all 3 are translated again along the Y axis the result is a grid where all of the feature names
correspond to their relative position:

O
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The Copies inherit last system of preceding block checkbox is used to translate a section of features
such that each copy will be relative to the preceding copy (as opposed to each copy being relative
to the system chosen in the dialog).

This can be particularly useful when making copies to track a curve or surface with unknown
geometry such as the free form of a flexible piece of plastic. For example, if you translate the
following group of three features relative to system PCS

it will create point 13, system 14, and point 15. The parent system for point 15 will always be
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system 14, however the parent system for features 13 and 14 will either be PCS (if the Copies
inherit last system of preceding block is not checked) or will be system 11 (if the Copies inherit last
system of preceding block is checked).

Linear
A linear translation command will move or copy the selected features.
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After selecting the proper system, enter the values for the translation. You have the choice of
making copies which will be separated by the given translation interval, or moving the selected
features. The selected features will be copied or moved when you click on OK. Remember that
these features have not been measured. It is often helpful to test the locations of copied features.
You can select one of the features and use the Remeasure command to verify that the tool position
is correct.

Grid
The Grid tab allows for features to be translated along 2 different axes with a single step.
Translste E
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The option to Move first in X or Y will effect the numbering of the features created. The Append
copy number to feature names option is useful to automatically create feature names that
correspond to positions in the grid.

Table

The Table tab provides the functionality of being able to create features or blocks of features in a
pattern that is not defined by standard geometric shapes.
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With this option, it is possible to copy and paste values from a spreadsheet into InSpec and create
features at those locations.

Rotate

The Rotate command in the Features Context Menu allows the user to rotate a feature or multiple
features in a program around the current system origin. This simplifies the programming of gear
teeth, bolt hole patterns and other symmetric arrangements of features. To transform multiple
features, select the group of features and then select Rotate from the Features Context Menu.
Enter the angle of rotation and whether to move the original features or create a number of copies.
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Checking Append copy number to feature names will add # to the end of each feature name
(including the source feature). For example, when BoltHoleCircle is rotated to create 3 copies, the
result will be BoltHoleCircle_1, BoltHoleCircle_2, BoltHoleCircle_3, and BoltHoleCircle_4.

Mirror

The Mirror command in the Features Context Menu allows the user to flip a feature or multiple
features in a program across the X or Y-axis. This simplifies the programming of symmetric
features. In the Mirror dialog box, select the axis to mirror across and whether to move the original
features or create a copy.

*irror =
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The Append copy number to feature names check box will add _# to the end of each feature
(including the source feature). For example, the result of making a mirrored copy of Line4 would
change the original feature to Line4_1 and create Line4_2.

Set System

Set System gives the user flexibility for taking measurements relative to different coordinate
systems. Users will find that although they wrote a program to measure a feature relative to one
coordinate system, they may want to know the location relative to a different system or to second
system.

Store Feature

InSpec software allows features to be stored in memory, so you can use them in other programs.

Storing a Feature is simple. First, Create a feature. Then choose Store from the Features Context
Menu (right click on the feature name). The following dialog will appear:

Skore Fes e

Check the box next to Store As and enter a unique name. By checking the Store Permanently box
you will save the feature permanently. If you do not check the box, the feature will be saved only for
the current session of InSpec and will be deleted when InSpec is closed.

Fixtures are often used to position parts on the stage. By storing and using the location of a fixture,
part programs can run completely automated without operator input. All the operator has to do is
load the part and click on the Run icon.

First make a short program that creates a system origin and skew on the fixture. Store the system.
Then begin the part program with a system that “Recalls” the stored feature. When you run the part
program, InSpec will know where the part is supposed to be and can begin measuring without any
user input.

Edit Solution

There are a number of constructions that have multiple solutions. For instance a line may intersect
with a circle in two locations. When you program a part a dialog box will pop up and allow you to
select the correct solution. However if the wrong solution was selected, the Edit Solution option can
be used to view and select the correct construction. The bold crosshairs shows the selected
construction point.

Edit Text

This option will allow you to edit existing text in a Text and Prompt type features. The dialog will
give you the options to accept, reset, and cancel any changes.
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This feature is convenient for exporting text to a data file, especially for cases where the text does
not change very often. For instance, if you measured twenty samples per lot, the text message may
say “LOT #7909.” This could be exported with the data. For the next lot of twenty samples, you
could Edit Text to change the number. This would be more convenient than using a Prompt feature
that requires user input for each run.

Playback

The playback setting can either be set to enabled or disabled. By default it is set as enabled, which
means that when the program is run again, the feature will be measured. When the playback is set
to disabled, the feature will become light gray in the schematic, and will not be measured next time
the program is run.

A disabled feature will not appear in the Log View. If another feature is dependent on a playback-
disabled feature, it will not measure either. You should not use playback-disabled features to define
systems, or as constructions.

A disabled feature can be useful if the programmer would like to reference an outline of the part in
the schematic, but does not actually want to measure the outline each time the program is run.
Set / Clear Drive Point

Drive Points can be used to reduce measurement time or for special lighting.

Normally InSpec drives to the center of a tool and “grabs” an image.

Drive points allow the user to define the X-Y-Z location of the “grab” for a feature.

If a three by three array of holes fit in the field of view, you could position the stage on the center
hole, select the nine diameters, and then set the drive point. During the run of the program, InSpec
will take a single snapshot and use it to take measurements of all nine holes.

Likewise if the four sides of a small rectangle fit in the field of view, drive to the center, measure the
four sides with F-Scan Line tools, and set the drive point for the rectangle. Then move on to the
next feature.

If lighting is better with a feature off-center, use the drive point to lock the X-Y-Z position of the
image grab.

Set Zoom/Lights

The lighting and zoom settings are important for a program to run consistently from one part to the
next. It may be helpful to raise the lighting or to decrease the zoom setting to make a program more
reliable. When you use Set Zoom/Lights, InSpec will change the zoom and lights settings of the
selected features to the current zoom and lights settings.

Insert Here / Insert at End

The Insert features allow you to add features or copy features to rearrange the order that the
features are measured. The insertion bar will be placed above the selected feature when you
choose Insert Here, or at the end of the list when you select Insert at End.

Inputs List

The Inputs list, located below the Features list, displays the individual components used to create
the current feature. These entries tell how a feature was measured, whether vision tools or other
features were used for data points. Inputs can be selected, edited, and deleted individually.
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Inputs Context Menu
Right clicking on an Input brings up the following menu:

Dt
This menu lets you do the following to the Input:
Move Here — Drives the stage to where the Input was measured. This is available when vision
tools are used as Inputs.

Edit Prompt... — Displays a dialog box where you add and edit a prompt for the selected Input.
The prompts usually are used to instruct the operator where to place the current tool. These are
typically used at the beginning of a program or for manual points. If the Input is measured
automatically, the prompt will only appear briefly on the screen.

Pick Section — Allows editing of splines that have been used as inputs
Delete — Allows deletion of the current Input.
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Chapter 3 The Program Interface

Information about your part program is displayed in the lower left corner of the screen. The features
and inputs are listed on the left with the programming icons just to the right. This view will vary in
appearance depending on monitor resolution.

Features List

The Features list displays a list of the features in the program. Features are added to the list as you
create them the first time. When a program is run, features will be measured in the order that the
features appear in the list.
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A feature is usually some entity on a part that can be measured. InSpec can measure several types
of features including arcs, angles, circles, distances, ellipses, lines, o-rings, and points. Features
are measured from data points, field of view tools, or constructed from other features. There are
also text, prompt, command line, part separators, and temperature features.

A triangle on the right of the Features list indicates which is the “current feature.”
The “current selection” of features is highlighted.

Multiple features can be selected using the SHIFT and CTRL keys. Operations, such as deleting,
setting tolerances, or copying, are applied to the current selection of features.

Features Context Menu
Right clicking on a feature in the Features list will bring up the following menu:

Remessire

Eparts.. Fs

Toleranoes... F3
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Rename F2
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This menu provides the following functions:
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Remeasure — Recapture data for the selected feature(s).

Exports — Open an Exports dialog box to select export characteristics.
Tolerances... — Open a Tolerance dialog to set tolerance values for the selected feature(s).
Select All — Select all features in the program.

Delete — Delete the selected feature(s).

Rename ... — Change the name of the current feature.

Translate ... — Copy or Move selected feature(s) in X, Y, and Z.

Rotate... — Copy or Move selected feature(s) around the system origin.
Mirror... — Copy or Move selected feature(s) across the X or Y-axis.

Set System — Relate selected feature(s) to a different coordinate system.
Store... — Name and Save a feature for use in other programs.

Edit Solution... - Change some geometric constructions.

Edit Text... - Change the content of a Text feature.

Playback... - By enabling or disabling a feature, you can control whether it is measured the
next time the program is run.

Set/Clear Drive Point - Control the center location for capturing an image.

Set Zoom/Lights — Changes the zoom and light settings for all selected features to the
currently displayed zoom and lights settings.

Insert Here — Place the insertion bar in front of the current feature.
Insert at End — Place the insertion bar after the last feature.

Remeasure

This command is useful to test a tool on an edge or verify that the position of a translated feature is
correct without rerunning the entire program. If the feature precedes the first X-Y origin, the user
will be prompted to manually remeasure. If the feature follows the first system, InSpec will move to
and measure the feature automatically.

Exports

InSpec allows you to select individual characteristics of each feature to be exported to a data file.
You can select a single feature or a group of features when setting the characteristics to be
exported.

The export dialog box is a “pin up” box that remains on the screen as you select other features and
set exports. Use the “X” in the top right to close the dialog.
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To open the Feature Exports dialog box, first select the desired features in either the schematic or

the Features list. Right click on the features and select Exports from the context menu. The F4 hot
key will also open up the Feature Exports dialog.

Check the boxes for the properties and options you want to use. When your selection includes
multiple feature types, use the “Feature Type” drop down menu in the top left to select one feature
type at a time.

Export with Labels — This toggle allows the user to include labels with the exported data, such
as “Circle 10: Diameter.”

Export Nominals and Tolerances — This toggle will include tolerance values if available, for
each of the selected properties.

Property — These check boxes allow the user to specify which characteristics of the selected
features are to be exported.

Label — InSpec allows you to customize labels for exported data. If Export with Labels is
checked, InSpec will include a label with the export data. If no label is entered, then a default label
is created using the feature name and property. The label is in quotes to facilitate use in
spreadsheet and SPC software, i.e. “Circle 1: Center X".

Tolerances

InSpec has the ability to tolerance linear, angular, form, and positional dimensions. Tolerances can
be applied to a single feature or to multiple features.

For a single feature, the tolerance dialog box will display the available tolerances for the selected
feature type, as well as nominal values and calculated deviations from tolerance.

For multiple features, the dialog will only display the available tolerances for the selected feature
type. Nominal values will typically have question marks (???) indicating that the values for the the
features are different. If a number appears in the nominal column, then all of the features have the
same value, for example Z=0.
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The tolerance dialog box is a “pin-up” box that remains on the screen as you select other features
and set tolerances. Access the tolerance window through the Features Context Menu or by using
the F3 hot key.

Select All

This option can be used to pick all of the features in a program. You may want to use this so that
you can immediately tolerance features or delete all features to start a new program.

Delete

This is one of the most used features. When programming, you often find a better way to measure
a feature or change you mind after selecting a feature type. When you use “delete,” InSpec
assumes that you mean it and does not ask for confirmation.

Rename

InSpec automatically names features with a number. The name can be changed to an
alphanumeric phrase of up to 32 characters. The name is used in the program, summary, reports,
and tags. No two features in the same program can have the same name. A dialog box will appear
and allow you to enter your own name for the feature. The hot key for the rename dialog box is F2.

Eratiom 8

T

Translate

The Translate function allows the user to apply a transformation to a feature or a group of features.
First select the group of features and then select Translate from the Features Context Menu.
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At the top of the Translate menu box, first select the reference system for the translation. The
reference system will default to the parent system used by the feature directly above the 'Insert
Here' line. The default reference system will not be appropriate for every case.

By checking the Append copy number to feature names box InSpec will add _# to the end of each
feature name (including the source feature). For example, when feature Diameter is translated two
times along the X axis the result is Diameter_1, Diameter_2, and Diameter_3:
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And if all 3 are translated again along the Y axis the result is a grid where all of the feature names
correspond to their relative position:
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The Copies inherit last system of preceding block checkbox is used to translate a section of features
such that each copy will be relative to the preceding copy (as opposed to each copy being relative
to the system chosen in the dialog).

This can be particularly useful when making copies to track a curve or surface with unknown
geometry such as the free form of a flexible piece of plastic. For example, if you translate the
following group of three features relative to system PCS

it will create point 13, system 14, and point 15. The parent system for point 15 will always be
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system 14, however the parent system for features 13 and 14 will either be PCS (if the Copies
inherit last system of preceding block is not checked) or will be system 11 (if the Copies inherit last
system of preceding block is checked).

Linear
A linear translation command will move or copy the selected features.
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After selecting the proper system, enter the values for the translation. You have the choice of
making copies which will be separated by the given translation interval, or moving the selected
features. The selected features will be copied or moved when you click on OK. Remember that
these features have not been measured. It is often helpful to test the locations of copied features.
You can select one of the features and use the Remeasure command to verify that the tool position
is correct.

Grid
The Grid tab allows for features to be translated along 2 different axes with a single step.
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The option to Move first in X or Y will effect the numbering of the features created. The Append
copy number to feature names option is useful to automatically create feature names that
correspond to positions in the grid.

Table

The Table tab provides the functionality of being able to create features or blocks of features in a
pattern that is not defined by standard geometric shapes.
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With this option, it is possible to copy and paste values from a spreadsheet into InSpec and create
features at those locations.

Rotate

The Rotate command in the Features Context Menu allows the user to rotate a feature or multiple
features in a program around the current system origin. This simplifies the programming of gear
teeth, bolt hole patterns and other symmetric arrangements of features. To transform multiple
features, select the group of features and then select Rotate from the Features Context Menu.
Enter the angle of rotation and whether to move the original features or create a number of copies.
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Checking Append copy number to feature names will add # to the end of each feature name
(including the source feature). For example, when BoltHoleCircle is rotated to create 3 copies, the
result will be BoltHoleCircle_1, BoltHoleCircle_2, BoltHoleCircle_3, and BoltHoleCircle_4.

Mirror

The Mirror command in the Features Context Menu allows the user to flip a feature or multiple
features in a program across the X or Y-axis. This simplifies the programming of symmetric
features. In the Mirror dialog box, select the axis to mirror across and whether to move the original
features or create a copy.

*irror =

FMirror abucet: Mirrie with respect ko
e | L system paaT =

I Append copy number to Featire nomes
™ Copes inherit last system of preceding biock

[ ] coma |

file:///C:/Users/hihi/AppData/Local/Temp/~hhB821.htm 5/2/2018



Chapter 3 The Program Interface Page 8 of 10

The Append copy number to feature names check box will add _# to the end of each feature
(including the source feature). For example, the result of making a mirrored copy of Line4 would
change the original feature to Line4_1 and create Line4_2.

Set System

Set System gives the user flexibility for taking measurements relative to different coordinate
systems. Users will find that although they wrote a program to measure a feature relative to one
coordinate system, they may want to know the location relative to a different system or to second
system.

Store Feature

InSpec software allows features to be stored in memory, so you can use them in other programs.

Storing a Feature is simple. First, Create a feature. Then choose Store from the Features Context
Menu (right click on the feature name). The following dialog will appear:

Skore Fes e

Check the box next to Store As and enter a unique name. By checking the Store Permanently box
you will save the feature permanently. If you do not check the box, the feature will be saved only for
the current session of InSpec and will be deleted when InSpec is closed.

Fixtures are often used to position parts on the stage. By storing and using the location of a fixture,
part programs can run completely automated without operator input. All the operator has to do is
load the part and click on the Run icon.

First make a short program that creates a system origin and skew on the fixture. Store the system.
Then begin the part program with a system that “Recalls” the stored feature. When you run the part
program, InSpec will know where the part is supposed to be and can begin measuring without any
user input.

Edit Solution

There are a number of constructions that have multiple solutions. For instance a line may intersect
with a circle in two locations. When you program a part a dialog box will pop up and allow you to
select the correct solution. However if the wrong solution was selected, the Edit Solution option can
be used to view and select the correct construction. The bold crosshairs shows the selected
construction point.

Edit Text

This option will allow you to edit existing text in a Text and Prompt type features. The dialog will
give you the options to accept, reset, and cancel any changes.
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This feature is convenient for exporting text to a data file, especially for cases where the text does
not change very often. For instance, if you measured twenty samples per lot, the text message may
say “LOT #7909.” This could be exported with the data. For the next lot of twenty samples, you
could Edit Text to change the number. This would be more convenient than using a Prompt feature
that requires user input for each run.

Playback

The playback setting can either be set to enabled or disabled. By default it is set as enabled, which
means that when the program is run again, the feature will be measured. When the playback is set
to disabled, the feature will become light gray in the schematic, and will not be measured next time
the program is run.

A disabled feature will not appear in the Log View. If another feature is dependent on a playback-
disabled feature, it will not measure either. You should not use playback-disabled features to define
systems, or as constructions.

A disabled feature can be useful if the programmer would like to reference an outline of the part in
the schematic, but does not actually want to measure the outline each time the program is run.
Set / Clear Drive Point

Drive Points can be used to reduce measurement time or for special lighting.

Normally InSpec drives to the center of a tool and “grabs” an image.

Drive points allow the user to define the X-Y-Z location of the “grab” for a feature.

If a three by three array of holes fit in the field of view, you could position the stage on the center
hole, select the nine diameters, and then set the drive point. During the run of the program, InSpec
will take a single snapshot and use it to take measurements of all nine holes.

Likewise if the four sides of a small rectangle fit in the field of view, drive to the center, measure the
four sides with F-Scan Line tools, and set the drive point for the rectangle. Then move on to the
next feature.

If lighting is better with a feature off-center, use the drive point to lock the X-Y-Z position of the
image grab.

Set Zoom/Lights

The lighting and zoom settings are important for a program to run consistently from one part to the
next. It may be helpful to raise the lighting or to decrease the zoom setting to make a program more
reliable. When you use Set Zoom/Lights, InSpec will change the zoom and lights settings of the
selected features to the current zoom and lights settings.

Insert Here / Insert at End

The Insert features allow you to add features or copy features to rearrange the order that the
features are measured. The insertion bar will be placed above the selected feature when you
choose Insert Here, or at the end of the list when you select Insert at End.

Inputs List

The Inputs list, located below the Features list, displays the individual components used to create
the current feature. These entries tell how a feature was measured, whether vision tools or other
features were used for data points. Inputs can be selected, edited, and deleted individually.
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Inputs Context Menu
Right clicking on an Input brings up the following menu:

Dt
This menu lets you do the following to the Input:
Move Here — Drives the stage to where the Input was measured. This is available when vision
tools are used as Inputs.

Edit Prompt... — Displays a dialog box where you add and edit a prompt for the selected Input.
The prompts usually are used to instruct the operator where to place the current tool. These are
typically used at the beginning of a program or for manual points. If the Input is measured
automatically, the prompt will only appear briefly on the screen.

Pick Section — Allows editing of splines that have been used as inputs
Delete — Allows deletion of the current Input.

file:///C:/Users/hihi/AppData/Local/Temp/~hhB821.htm 5/2/2018



Chapter 3 The Program Interface Page 1 of 10

Chapter 3 The Program Interface

Information about your part program is displayed in the lower left corner of the screen. The features
and inputs are listed on the left with the programming icons just to the right. This view will vary in
appearance depending on monitor resolution.

Features List

The Features list displays a list of the features in the program. Features are added to the list as you
create them the first time. When a program is run, features will be measured in the order that the
features appear in the list.

Features a
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A feature is usually some entity on a part that can be measured. InSpec can measure several types
of features including arcs, angles, circles, distances, ellipses, lines, o-rings, and points. Features
are measured from data points, field of view tools, or constructed from other features. There are
also text, prompt, command line, part separators, and temperature features.

A triangle on the right of the Features list indicates which is the “current feature.”
The “current selection” of features is highlighted.

Multiple features can be selected using the SHIFT and CTRL keys. Operations, such as deleting,
setting tolerances, or copying, are applied to the current selection of features.

Features Context Menu
Right clicking on a feature in the Features list will bring up the following menu:

Remessire

Eparts.. Fs

Toleranoes... F3

Salact Al Chrl+4

[relate Dred

Rename F2

Trarslabe. .,

Ratata. ..

Sl System,.,

Share .
BT ¢
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Sat. Lights[Zoom

irsert Here e

Irsert &t End Chrl+Ins

This menu provides the following functions:
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Remeasure — Recapture data for the selected feature(s).

Exports — Open an Exports dialog box to select export characteristics.
Tolerances... — Open a Tolerance dialog to set tolerance values for the selected feature(s).
Select All — Select all features in the program.

Delete — Delete the selected feature(s).

Rename ... — Change the name of the current feature.

Translate ... — Copy or Move selected feature(s) in X, Y, and Z.

Rotate... — Copy or Move selected feature(s) around the system origin.
Mirror... — Copy or Move selected feature(s) across the X or Y-axis.

Set System — Relate selected feature(s) to a different coordinate system.
Store... — Name and Save a feature for use in other programs.

Edit Solution... - Change some geometric constructions.

Edit Text... - Change the content of a Text feature.

Playback... - By enabling or disabling a feature, you can control whether it is measured the
next time the program is run.

Set/Clear Drive Point - Control the center location for capturing an image.

Set Zoom/Lights — Changes the zoom and light settings for all selected features to the
currently displayed zoom and lights settings.

Insert Here — Place the insertion bar in front of the current feature.
Insert at End — Place the insertion bar after the last feature.

Remeasure

This command is useful to test a tool on an edge or verify that the position of a translated feature is
correct without rerunning the entire program. If the feature precedes the first X-Y origin, the user
will be prompted to manually remeasure. If the feature follows the first system, InSpec will move to
and measure the feature automatically.

Exports

InSpec allows you to select individual characteristics of each feature to be exported to a data file.
You can select a single feature or a group of features when setting the characteristics to be
exported.

The export dialog box is a “pin up” box that remains on the screen as you select other features and
set exports. Use the “X” in the top right to close the dialog.
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_ g |
To open the Feature Exports dialog box, first select the desired features in either the schematic or

the Features list. Right click on the features and select Exports from the context menu. The F4 hot
key will also open up the Feature Exports dialog.

Check the boxes for the properties and options you want to use. When your selection includes
multiple feature types, use the “Feature Type” drop down menu in the top left to select one feature
type at a time.

Export with Labels — This toggle allows the user to include labels with the exported data, such
as “Circle 10: Diameter.”

Export Nominals and Tolerances — This toggle will include tolerance values if available, for
each of the selected properties.

Property — These check boxes allow the user to specify which characteristics of the selected
features are to be exported.

Label — InSpec allows you to customize labels for exported data. If Export with Labels is
checked, InSpec will include a label with the export data. If no label is entered, then a default label
is created using the feature name and property. The label is in quotes to facilitate use in
spreadsheet and SPC software, i.e. “Circle 1: Center X".

Tolerances

InSpec has the ability to tolerance linear, angular, form, and positional dimensions. Tolerances can
be applied to a single feature or to multiple features.

For a single feature, the tolerance dialog box will display the available tolerances for the selected
feature type, as well as nominal values and calculated deviations from tolerance.

For multiple features, the dialog will only display the available tolerances for the selected feature
type. Nominal values will typically have question marks (???) indicating that the values for the the
features are different. If a number appears in the nominal column, then all of the features have the
same value, for example Z=0.
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The tolerance dialog box is a “pin-up” box that remains on the screen as you select other features
and set tolerances. Access the tolerance window through the Features Context Menu or by using
the F3 hot key.

Select All

This option can be used to pick all of the features in a program. You may want to use this so that
you can immediately tolerance features or delete all features to start a new program.

Delete

This is one of the most used features. When programming, you often find a better way to measure
a feature or change you mind after selecting a feature type. When you use “delete,” InSpec
assumes that you mean it and does not ask for confirmation.

Rename

InSpec automatically names features with a number. The name can be changed to an
alphanumeric phrase of up to 32 characters. The name is used in the program, summary, reports,
and tags. No two features in the same program can have the same name. A dialog box will appear
and allow you to enter your own name for the feature. The hot key for the rename dialog box is F2.

Eratiom 8

T

Translate

The Translate function allows the user to apply a transformation to a feature or a group of features.
First select the group of features and then select Translate from the Features Context Menu.
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At the top of the Translate menu box, first select the reference system for the translation. The
reference system will default to the parent system used by the feature directly above the 'Insert
Here' line. The default reference system will not be appropriate for every case.

By checking the Append copy number to feature names box InSpec will add _# to the end of each
feature name (including the source feature). For example, when feature Diameter is translated two
times along the X axis the result is Diameter_1, Diameter_2, and Diameter_3:

[ 48 Bttt 3 M Tl 5 T

®
>

And if all 3 are translated again along the Y axis the result is a grid where all of the feature names
correspond to their relative position:

O
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The Copies inherit last system of preceding block checkbox is used to translate a section of features
such that each copy will be relative to the preceding copy (as opposed to each copy being relative
to the system chosen in the dialog).

This can be particularly useful when making copies to track a curve or surface with unknown
geometry such as the free form of a flexible piece of plastic. For example, if you translate the
following group of three features relative to system PCS

it will create point 13, system 14, and point 15. The parent system for point 15 will always be

file:///C:/Users/hihi/AppData/Local/Temp/~hh4695.htm 5/2/2018



Chapter 3 The Program Interface Page 6 of 10

system 14, however the parent system for features 13 and 14 will either be PCS (if the Copies
inherit last system of preceding block is not checked) or will be system 11 (if the Copies inherit last
system of preceding block is checked).

Linear
A linear translation command will move or copy the selected features.
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After selecting the proper system, enter the values for the translation. You have the choice of
making copies which will be separated by the given translation interval, or moving the selected
features. The selected features will be copied or moved when you click on OK. Remember that
these features have not been measured. It is often helpful to test the locations of copied features.
You can select one of the features and use the Remeasure command to verify that the tool position
is correct.

Grid
The Grid tab allows for features to be translated along 2 different axes with a single step.
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The option to Move first in X or Y will effect the numbering of the features created. The Append
copy number to feature names option is useful to automatically create feature names that
correspond to positions in the grid.

Table

The Table tab provides the functionality of being able to create features or blocks of features in a
pattern that is not defined by standard geometric shapes.

file:///C:/Users/hihi/AppData/Local/Temp/~hh4695.htm 5/2/2018



Chapter 3 The Program Interface Page 7 of 10

o Ui | BB coa 30 7ol |

Translate
£ ! | Z

[T L.2500)  4.3500
[Tz £.4500 | 8,350 |

3 46500 | 7.5000

4 SLAS00 1,500 I

5 B 70 12,2500 |
[ =
Transiate vath respect to;
[ L System pes =]
I append oph: rsiber to Feabise nares
™ Copiesinbent et spstom of pracading block

w | e |

With this option, it is possible to copy and paste values from a spreadsheet into InSpec and create
features at those locations.

Rotate

The Rotate command in the Features Context Menu allows the user to rotate a feature or multiple
features in a program around the current system origin. This simplifies the programming of gear
teeth, bolt hole patterns and other symmetric arrangements of features. To transform multiple
features, select the group of features and then select Rotate from the Features Context Menu.
Enter the angle of rotation and whether to move the original features or create a number of copies.
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Checking Append copy number to feature names will add # to the end of each feature name
(including the source feature). For example, when BoltHoleCircle is rotated to create 3 copies, the
result will be BoltHoleCircle_1, BoltHoleCircle_2, BoltHoleCircle_3, and BoltHoleCircle_4.

Mirror

The Mirror command in the Features Context Menu allows the user to flip a feature or multiple
features in a program across the X or Y-axis. This simplifies the programming of symmetric
features. In the Mirror dialog box, select the axis to mirror across and whether to move the original
features or create a copy.
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The Append copy number to feature names check box will add _# to the end of each feature
(including the source feature). For example, the result of making a mirrored copy of Line4 would
change the original feature to Line4_1 and create Line4_2.

Set System

Set System gives the user flexibility for taking measurements relative to different coordinate
systems. Users will find that although they wrote a program to measure a feature relative to one
coordinate system, they may want to know the location relative to a different system or to second
system.

Store Feature

InSpec software allows features to be stored in memory, so you can use them in other programs.

Storing a Feature is simple. First, Create a feature. Then choose Store from the Features Context
Menu (right click on the feature name). The following dialog will appear:

Skore Fes e

Check the box next to Store As and enter a unique name. By checking the Store Permanently box
you will save the feature permanently. If you do not check the box, the feature will be saved only for
the current session of InSpec and will be deleted when InSpec is closed.

Fixtures are often used to position parts on the stage. By storing and using the location of a fixture,
part programs can run completely automated without operator input. All the operator has to do is
load the part and click on the Run icon.

First make a short program that creates a system origin and skew on the fixture. Store the system.
Then begin the part program with a system that “Recalls” the stored feature. When you run the part
program, InSpec will know where the part is supposed to be and can begin measuring without any
user input.

Edit Solution

There are a number of constructions that have multiple solutions. For instance a line may intersect
with a circle in two locations. When you program a part a dialog box will pop up and allow you to
select the correct solution. However if the wrong solution was selected, the Edit Solution option can
be used to view and select the correct construction. The bold crosshairs shows the selected
construction point.

Edit Text

This option will allow you to edit existing text in a Text and Prompt type features. The dialog will
give you the options to accept, reset, and cancel any changes.
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This feature is convenient for exporting text to a data file, especially for cases where the text does
not change very often. For instance, if you measured twenty samples per lot, the text message may
say “LOT #7909.” This could be exported with the data. For the next lot of twenty samples, you
could Edit Text to change the number. This would be more convenient than using a Prompt feature
that requires user input for each run.

Playback

The playback setting can either be set to enabled or disabled. By default it is set as enabled, which
means that when the program is run again, the feature will be measured. When the playback is set
to disabled, the feature will become light gray in the schematic, and will not be measured next time
the program is run.

A disabled feature will not appear in the Log View. If another feature is dependent on a playback-
disabled feature, it will not measure either. You should not use playback-disabled features to define
systems, or as constructions.

A disabled feature can be useful if the programmer would like to reference an outline of the part in
the schematic, but does not actually want to measure the outline each time the program is run.
Set / Clear Drive Point

Drive Points can be used to reduce measurement time or for special lighting.

Normally InSpec drives to the center of a tool and “grabs” an image.

Drive points allow the user to define the X-Y-Z location of the “grab” for a feature.

If a three by three array of holes fit in the field of view, you could position the stage on the center
hole, select the nine diameters, and then set the drive point. During the run of the program, InSpec
will take a single snapshot and use it to take measurements of all nine holes.

Likewise if the four sides of a small rectangle fit in the field of view, drive to the center, measure the
four sides with F-Scan Line tools, and set the drive point for the rectangle. Then move on to the
next feature.

If lighting is better with a feature off-center, use the drive point to lock the X-Y-Z position of the
image grab.

Set Zoom/Lights

The lighting and zoom settings are important for a program to run consistently from one part to the
next. It may be helpful to raise the lighting or to decrease the zoom setting to make a program more
reliable. When you use Set Zoom/Lights, InSpec will change the zoom and lights settings of the
selected features to the current zoom and lights settings.

Insert Here / Insert at End

The Insert features allow you to add features or copy features to rearrange the order that the
features are measured. The insertion bar will be placed above the selected feature when you
choose Insert Here, or at the end of the list when you select Insert at End.

Inputs List

The Inputs list, located below the Features list, displays the individual components used to create
the current feature. These entries tell how a feature was measured, whether vision tools or other
features were used for data points. Inputs can be selected, edited, and deleted individually.
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Inputs Context Menu
Right clicking on an Input brings up the following menu:

Dt
This menu lets you do the following to the Input:
Move Here — Drives the stage to where the Input was measured. This is available when vision
tools are used as Inputs.

Edit Prompt... — Displays a dialog box where you add and edit a prompt for the selected Input.
The prompts usually are used to instruct the operator where to place the current tool. These are
typically used at the beginning of a program or for manual points. If the Input is measured
automatically, the prompt will only appear briefly on the screen.

Pick Section — Allows editing of splines that have been used as inputs
Delete — Allows deletion of the current Input.
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Chapter 3 The Program Interface

Information about your part program is displayed in the lower left corner of the screen. The features
and inputs are listed on the left with the programming icons just to the right. This view will vary in
appearance depending on monitor resolution.

Features List

The Features list displays a list of the features in the program. Features are added to the list as you
create them the first time. When a program is run, features will be measured in the order that the
features appear in the list.
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A feature is usually some entity on a part that can be measured. InSpec can measure several types
of features including arcs, angles, circles, distances, ellipses, lines, o-rings, and points. Features
are measured from data points, field of view tools, or constructed from other features. There are
also text, prompt, command line, part separators, and temperature features.

A triangle on the right of the Features list indicates which is the “current feature.”
The “current selection” of features is highlighted.

Multiple features can be selected using the SHIFT and CTRL keys. Operations, such as deleting,
setting tolerances, or copying, are applied to the current selection of features.

Features Context Menu
Right clicking on a feature in the Features list will bring up the following menu:

Remessire

Eparts.. Fs

Toleranoes... F3

Salact Al Chrl+4

[relate Dred

Rename F2

Trarslabe. .,

Ratata. ..

Sl System,.,

Share .
BT ¢

Sak Crive Point Chrl+D .ﬂ

Sat. Lights[Zoom

irsert Here e

Irsert &t End Chrl+Ins

This menu provides the following functions:
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Remeasure — Recapture data for the selected feature(s).

Exports — Open an Exports dialog box to select export characteristics.
Tolerances... — Open a Tolerance dialog to set tolerance values for the selected feature(s).
Select All — Select all features in the program.

Delete — Delete the selected feature(s).

Rename ... — Change the name of the current feature.

Translate ... — Copy or Move selected feature(s) in X, Y, and Z.

Rotate... — Copy or Move selected feature(s) around the system origin.
Mirror... — Copy or Move selected feature(s) across the X or Y-axis.

Set System — Relate selected feature(s) to a different coordinate system.
Store... — Name and Save a feature for use in other programs.

Edit Solution... - Change some geometric constructions.

Edit Text... - Change the content of a Text feature.

Playback... - By enabling or disabling a feature, you can control whether it is measured the
next time the program is run.

Set/Clear Drive Point - Control the center location for capturing an image.

Set Zoom/Lights — Changes the zoom and light settings for all selected features to the
currently displayed zoom and lights settings.

Insert Here — Place the insertion bar in front of the current feature.
Insert at End — Place the insertion bar after the last feature.

Remeasure

This command is useful to test a tool on an edge or verify that the position of a translated feature is
correct without rerunning the entire program. If the feature precedes the first X-Y origin, the user
will be prompted to manually remeasure. If the feature follows the first system, InSpec will move to
and measure the feature automatically.

Exports

InSpec allows you to select individual characteristics of each feature to be exported to a data file.
You can select a single feature or a group of features when setting the characteristics to be
exported.

The export dialog box is a “pin up” box that remains on the screen as you select other features and
set exports. Use the “X” in the top right to close the dialog.
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_ g |
To open the Feature Exports dialog box, first select the desired features in either the schematic or

the Features list. Right click on the features and select Exports from the context menu. The F4 hot
key will also open up the Feature Exports dialog.

Check the boxes for the properties and options you want to use. When your selection includes
multiple feature types, use the “Feature Type” drop down menu in the top left to select one feature
type at a time.

Export with Labels — This toggle allows the user to include labels with the exported data, such
as “Circle 10: Diameter.”

Export Nominals and Tolerances — This toggle will include tolerance values if available, for
each of the selected properties.

Property — These check boxes allow the user to specify which characteristics of the selected
features are to be exported.

Label — InSpec allows you to customize labels for exported data. If Export with Labels is
checked, InSpec will include a label with the export data. If no label is entered, then a default label
is created using the feature name and property. The label is in quotes to facilitate use in
spreadsheet and SPC software, i.e. “Circle 1: Center X".

Tolerances

InSpec has the ability to tolerance linear, angular, form, and positional dimensions. Tolerances can
be applied to a single feature or to multiple features.

For a single feature, the tolerance dialog box will display the available tolerances for the selected
feature type, as well as nominal values and calculated deviations from tolerance.

For multiple features, the dialog will only display the available tolerances for the selected feature
type. Nominal values will typically have question marks (???) indicating that the values for the the
features are different. If a number appears in the nominal column, then all of the features have the
same value, for example Z=0.
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The tolerance dialog box is a “pin-up” box that remains on the screen as you select other features
and set tolerances. Access the tolerance window through the Features Context Menu or by using
the F3 hot key.

Select All

This option can be used to pick all of the features in a program. You may want to use this so that
you can immediately tolerance features or delete all features to start a new program.

Delete

This is one of the most used features. When programming, you often find a better way to measure
a feature or change you mind after selecting a feature type. When you use “delete,” InSpec
assumes that you mean it and does not ask for confirmation.

Rename

InSpec automatically names features with a number. The name can be changed to an
alphanumeric phrase of up to 32 characters. The name is used in the program, summary, reports,
and tags. No two features in the same program can have the same name. A dialog box will appear
and allow you to enter your own name for the feature. The hot key for the rename dialog box is F2.

Eratiom 8

T

Translate

The Translate function allows the user to apply a transformation to a feature or a group of features.
First select the group of features and then select Translate from the Features Context Menu.

file:///C:/Users/hihi/AppData/Local/Temp/~hhF332.htm 5/2/2018



Chapter 3 The Program Interface Page 5 of 10

apsh Lingar | Bl | £ Tabte |

Translate | Trareiabe with réspect toe
(81  25m0]  [L sysempcs =
i | 00000 |
|2 2.0000 |

3 Cregte copies; E] ﬂ.

" Mows selection

[+ -appand copy rember ko Feabing names
[ Coples inherk Laek system of precedng block

cx}cmi

At the top of the Translate menu box, first select the reference system for the translation. The
reference system will default to the parent system used by the feature directly above the 'Insert
Here' line. The default reference system will not be appropriate for every case.

By checking the Append copy number to feature names box InSpec will add _# to the end of each
feature name (including the source feature). For example, when feature Diameter is translated two
times along the X axis the result is Diameter_1, Diameter_2, and Diameter_3:

[ 48 Bttt 3 M Tl 5 T

®
>

And if all 3 are translated again along the Y axis the result is a grid where all of the feature names
correspond to their relative position:

O
O
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| @ Diametier_1 2] [ @ Diameter_2_2|| @ Dameter 3.2
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The Copies inherit last system of preceding block checkbox is used to translate a section of features
such that each copy will be relative to the preceding copy (as opposed to each copy being relative
to the system chosen in the dialog).

This can be particularly useful when making copies to track a curve or surface with unknown
geometry such as the free form of a flexible piece of plastic. For example, if you translate the
following group of three features relative to system PCS

it will create point 13, system 14, and point 15. The parent system for point 15 will always be
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system 14, however the parent system for features 13 and 14 will either be PCS (if the Copies
inherit last system of preceding block is not checked) or will be system 11 (if the Copies inherit last
system of preceding block is checked).

Linear
A linear translation command will move or copy the selected features.
agen Lingar |§§§* g | $4 Tatle |

Translate | Trarelsbe with réspect b

(% fam]
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After selecting the proper system, enter the values for the translation. You have the choice of
making copies which will be separated by the given translation interval, or moving the selected
features. The selected features will be copied or moved when you click on OK. Remember that
these features have not been measured. It is often helpful to test the locations of copied features.
You can select one of the features and use the Remeasure command to verify that the tool position
is correct.

Grid
The Grid tab allows for features to be translated along 2 different axes with a single step.
Translste E
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The option to Move first in X or Y will effect the numbering of the features created. The Append
copy number to feature names option is useful to automatically create feature names that
correspond to positions in the grid.

Table

The Table tab provides the functionality of being able to create features or blocks of features in a
pattern that is not defined by standard geometric shapes.
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With this option, it is possible to copy and paste values from a spreadsheet into InSpec and create
features at those locations.

Rotate

The Rotate command in the Features Context Menu allows the user to rotate a feature or multiple
features in a program around the current system origin. This simplifies the programming of gear
teeth, bolt hole patterns and other symmetric arrangements of features. To transform multiple
features, select the group of features and then select Rotate from the Features Context Menu.
Enter the angle of rotation and whether to move the original features or create a number of copies.

rotate
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Checking Append copy number to feature names will add # to the end of each feature name
(including the source feature). For example, when BoltHoleCircle is rotated to create 3 copies, the
result will be BoltHoleCircle_1, BoltHoleCircle_2, BoltHoleCircle_3, and BoltHoleCircle_4.

Mirror

The Mirror command in the Features Context Menu allows the user to flip a feature or multiple
features in a program across the X or Y-axis. This simplifies the programming of symmetric
features. In the Mirror dialog box, select the axis to mirror across and whether to move the original
features or create a copy.

*irror =
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e | L system paaT =

I Append copy number to Featire nomes
™ Copes inherit last system of preceding biock

[ ] coma |
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The Append copy number to feature names check box will add _# to the end of each feature
(including the source feature). For example, the result of making a mirrored copy of Line4 would
change the original feature to Line4_1 and create Line4_2.

Set System

Set System gives the user flexibility for taking measurements relative to different coordinate
systems. Users will find that although they wrote a program to measure a feature relative to one
coordinate system, they may want to know the location relative to a different system or to second
system.

Store Feature

InSpec software allows features to be stored in memory, so you can use them in other programs.

Storing a Feature is simple. First, Create a feature. Then choose Store from the Features Context
Menu (right click on the feature name). The following dialog will appear:

Skore Fes e

Check the box next to Store As and enter a unique name. By checking the Store Permanently box
you will save the feature permanently. If you do not check the box, the feature will be saved only for
the current session of InSpec and will be deleted when InSpec is closed.

Fixtures are often used to position parts on the stage. By storing and using the location of a fixture,
part programs can run completely automated without operator input. All the operator has to do is
load the part and click on the Run icon.

First make a short program that creates a system origin and skew on the fixture. Store the system.
Then begin the part program with a system that “Recalls” the stored feature. When you run the part
program, InSpec will know where the part is supposed to be and can begin measuring without any
user input.

Edit Solution

There are a number of constructions that have multiple solutions. For instance a line may intersect
with a circle in two locations. When you program a part a dialog box will pop up and allow you to
select the correct solution. However if the wrong solution was selected, the Edit Solution option can
be used to view and select the correct construction. The bold crosshairs shows the selected
construction point.

Edit Text

This option will allow you to edit existing text in a Text and Prompt type features. The dialog will
give you the options to accept, reset, and cancel any changes.
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This feature is convenient for exporting text to a data file, especially for cases where the text does
not change very often. For instance, if you measured twenty samples per lot, the text message may
say “LOT #7909.” This could be exported with the data. For the next lot of twenty samples, you
could Edit Text to change the number. This would be more convenient than using a Prompt feature
that requires user input for each run.

Playback

The playback setting can either be set to enabled or disabled. By default it is set as enabled, which
means that when the program is run again, the feature will be measured. When the playback is set
to disabled, the feature will become light gray in the schematic, and will not be measured next time
the program is run.

A disabled feature will not appear in the Log View. If another feature is dependent on a playback-
disabled feature, it will not measure either. You should not use playback-disabled features to define
systems, or as constructions.

A disabled feature can be useful if the programmer would like to reference an outline of the part in
the schematic, but does not actually want to measure the outline each time the program is run.
Set / Clear Drive Point

Drive Points can be used to reduce measurement time or for special lighting.

Normally InSpec drives to the center of a tool and “grabs” an image.

Drive points allow the user to define the X-Y-Z location of the “grab” for a feature.

If a three by three array of holes fit in the field of view, you could position the stage on the center
hole, select the nine diameters, and then set the drive point. During the run of the program, InSpec
will take a single snapshot and use it to take measurements of all nine holes.

Likewise if the four sides of a small rectangle fit in the field of view, drive to the center, measure the
four sides with F-Scan Line tools, and set the drive point for the rectangle. Then move on to the
next feature.

If lighting is better with a feature off-center, use the drive point to lock the X-Y-Z position of the
image grab.

Set Zoom/Lights

The lighting and zoom settings are important for a program to run consistently from one part to the
next. It may be helpful to raise the lighting or to decrease the zoom setting to make a program more
reliable. When you use Set Zoom/Lights, InSpec will change the zoom and lights settings of the
selected features to the current zoom and lights settings.

Insert Here / Insert at End

The Insert features allow you to add features or copy features to rearrange the order that the
features are measured. The insertion bar will be placed above the selected feature when you
choose Insert Here, or at the end of the list when you select Insert at End.

Inputs List

The Inputs list, located below the Features list, displays the individual components used to create
the current feature. These entries tell how a feature was measured, whether vision tools or other
features were used for data points. Inputs can be selected, edited, and deleted individually.
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Inputs Context Menu
Right clicking on an Input brings up the following menu:

Dt
This menu lets you do the following to the Input:
Move Here — Drives the stage to where the Input was measured. This is available when vision
tools are used as Inputs.

Edit Prompt... — Displays a dialog box where you add and edit a prompt for the selected Input.
The prompts usually are used to instruct the operator where to place the current tool. These are
typically used at the beginning of a program or for manual points. If the Input is measured
automatically, the prompt will only appear briefly on the screen.

Pick Section — Allows editing of splines that have been used as inputs
Delete — Allows deletion of the current Input.

file:///C:/Users/hihi/AppData/Local/Temp/~hhF332.htm 5/2/2018



Chapter 7 Other Icons Page 1 of 1

Chapter 7 Other Icons

Schematic Zoom

Customers use Micro-Vu systems to measure a variety of parts. Some larger parts have small features.
InSpec provides zoom capabilities in the schematic so that you can view the relative position of these
features.

Use the Fit and Zoom Icons directly below the Schematic window to zoom in on smaller features and zoom
out to see the entire Schematic.

E The Zoom-In icon toggles between the “Zoom” state and the “Pick” state. When the button is pressed,
the mouse cursor will show a magnifying glass when the mouse is in the Schematic window. To zoom in
on features, click-and-drag a window around the area you would like to enlarge.

ET he Zoom-Out icon incrementally decreases the zoom so that you can make slight increases to the
field of view.

H The Zoom-to-Fit icon changes the Schematic zoom to display all of the features in the program and the
location of the current stage position. Note that if the camera location is not near the part and the part is
relatively small, then the part features will appear small on the screen.

Tags

-
% The Tags icon allows the user to mark selected features on the Schematic. This makes it easier for
the user to locate specific features. The user may select a group of features from the Features list and
change the tag status for all of the selected features at one time. A feature’s Tag displays the number or
name of the feature. When a feature is renamed the feature’s name is displayed in place of its number.

Playback Icons

The Playback icons allow the user to start from the beginning, stop, and continue the playback of a part
program.

r-«
** Run

The Run icon starts the current measurement program from the top of the Features list. Manual points and
features measured to create the first system will require operator input.

jContinue

The Continue icon restarts the measurement after the process has been paused or stopped. Continue
starts the program from the current feature and progresses down the program list. This allows the user to
stop the program, skip features, and restart the measurement process if needed.

ﬂStop

The Stop icon will stop the measurement of a program. While stopped, measured features can be checked
and remeasured if needed. Use Continue to restart the measurement process.

ﬂReduce Speed

The Reduce Speed icon is only available when the touch probe is attached. It acts as a toggle between
two speeds. When you click on it, the button will stay down until you click on it again. This function is
helpful when testing touch probe programs. It gives the operator more time to stop the program in cases of
a collision.
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Chapter 8 Beginning to Measure

Micro-Vu’s InSpec software provides an easy-to-use, point-and-click style to create measurement
programs. InSpec records the lighting, zoom, and stage position settings for each tool as you
“teach” the first part.

Not only are programs easy to create, they are also easy to edit. Because of the Feature-Input
structure of the program created in InSpec, the user is allowed to go back and change individual
steps of the program.

When you open InSpec, the schematic window, features list, and inputs list will be empty. As you
teach InSpec the features on a part, the features will appear in the schematic and be listed in the
features list. The individual tools used to create each feature will appear in the inputs list. You can
save and open files from the File menu as you do in other Windows based programs.

Measuring the Sample Part

The following section shows step-by-step, icon-by-icon, how to measure a few features on the
sample part. Follow along step-by-step. Some of the steps are explained as they occur. Others
are better explained later in the manual. You should be familiar with the basic Windows operations
and the InSpec user interface before beginning.
Preparation

Turn on the computer and machine

Double click the InSpec icon to start InSpec.

Use the drop-down menu in the camera window to set the zoom to the lowest magnification
(i.e. approximately 15x, or similar depending on machine).

Using low magnification makes moving the stage easier for the beginner and allows you to use
“Field of View” tools on more features.

If the zoom drop down menu has numbers preceded by the pound (#) character, then a screen
calibration needs to be performed before continuing.
Set the profile lighting to approximately 20-30% and turn the other lighting off.

Orient the sample part on the stage as shown below. It is good practice to use clay or clips to
hold the part in place.

Creating a System

To get a program to run on its own, a part coordinate system must be established. Create a
coordinate system on the lower left-hand corner of the part. The corner can be located by
intersecting two lines. Begin the program by creating a line near the lower left-hand corner of the
part.

Click on Line AI from the feature icons and select the Feature
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Scan Line _] from the tool icons.

Left click in two places on the horizontal edge. Line 1 will be displayed in the Features list.
InSpec will create a search zone displayed with the dashed line. The image will be processed and
a magenta line will show the operator the measured line segment. The width of the search zone
can be adjusted by click and dragging the dashed line. The length and position can be adjusted by
click and dragging the control points, the green boxes.

To remind the next operator where this line was measured, a Tool Prompt can be displayed.

With Line 1 highlighted in the Features list, right click on the text in the Inputs list. This will
display the Inputs Context Menu.

Click on Edit Prompt and the Tool Prompt dialog will appear allowing the desired text to be
entered.

Type, “Measure a horizontal line near the lower left corner of part.” The text will be displayed
when you run the program.

Move the stage to view the vertical edge of the part. Notice that the field of View Line tool is
still selected.

Left click twice on the vertical edge. Line 2 will be displayed in the Features list.

Add another Prompt as a reminder.

Select Line 2 in the Features list, right click on the text displayed in the Inputs list, select Edit
Prompt, and enter the text to be displayed during playback. Type, “Create a vertical line near lower
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left corner of part.”

L ]
Now create a point at the intersection of the two lines. Click on Point _I from the Feature

icons and then on Intersect _| from the Construction icons. Now point and click on Line 1 and
then Line 2 in the Features list with the mouse.

You can select Line 1 and Line 2 from the Features list or from the schematic. Notice that the
shape of the pointer changes to a hand when the object beneath is a valid input. When the pointer
is over a feature in the schematic window, the feature will change from green to pink. A point will
appear on the schematic as a small crosshairs. Point 3.

A coordinate system is needed to establish a “zero” point and to set the alignment of the counting
direction to that of the part.

Click on System . feature icon and System 4 will appear in the Features list. Click on Skew
5

* | from the Construction icons. Skew to Line 2 by clicking on Line 2 in the Features list or in
the Schematic window. The Skew construction will appear in the Inputs list.

0]
With System 4 still highlighted, click on Origin _‘| from the construction icons to create and
X-Y-Z origin. Select Point 3 by clicking on Point 3 with the hand. The Origin construction will
appear in the Inputs list.

A coordinate system will be displayed on the Schematic with an arrow indicating the positive X
direction. The counting direction is aligned to the part and the intersection point is now (0,0,0).

Now add more features to the program. InSpec records the offsets relative to the origin. This
allows the program to run automatically the next time, after the origin has been established.

Move the stage so that one of the circles is completely in the Camera Window.

Click on Circle J from the Feature icons and select the Field of View Circle J from

the Tool icons.

Click the three points on the circumference of the circle to place the Field of View Circle tool.
In the Camera Window, click and drag the dashed lines of the tool to change the size of the search
zone. Circle 5 will appear in the Features list.

The search zone will change from green to yellow if the zone exceeds the bounds of the view. The
size of the tool must be reduced until if fits in the view and can compute the edge (40x or lower
magnification is needed). The small green boxes are Control Points. Click and drag the control
points with the mouse to adjust the position of the tool.

If the circle does not fit in the camera window, select the Best Edge _| from the tool icons and
place three points on the circle.
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Move the stage so that the lower right arc is in the field of view.

* £
Click on the Arc _| from the Feature icons and the F-Scan Arc __| from the Tool icons.

Click three points on the arc. Arc 6 will appear in the Features list.

Move the stage so that another circle is in the field of view.

Click on Circle _I from the Feature icons and then select the Best Edge __| from the

Tool icons. Now select three points on the circle. As the points are entered, Best Edge tools will
appear in the Inputs list.
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Move the stage so that the upper left-hand portion of the part is in the field of view.

o
Click on Line _| from the Feature Icons and then the First Edge from the Tool

icons. Click on two points along the line.

After the points are entered, a First Edge tool will appear in the Inputs list. Notice that this is a
point tool. You have entered one of two points needed to construct a line. The arrow on the tool
indicates the directions of the search. A light blue line will trace the chosen edge, and a magenta
cross at the center of the line represents the single data point reported by the tool.

Move the stage to the other end of the line and click twice more along the line to place a
second First Edge point.

The line is now complete and will be drawn in the Schematic. Notice that you can click and drag the
control points (green squares) of the tool. You can also click and drag the dashed edge of the
search zone to resize and change the direction of the tool.

Running the Program

icon.

To run the program click on the Run !
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InSpec will highlight the first feature in the Feature list and the prompt will appear. Notice that the F-
Scan Line tool has already been selected for you.

Move the stage so that the lower left-hand corner of the part is in the field of view and create the line
tool on the horizontal edge, and enter the horizontal line.

Click on Continue _| and InSpec will advance to the next feature.

Move the stage to view the vertical edge. Then click twice to create a line tool on the vertical
edge.

4

Click on Continue _| after you have entered the vertical line and the program will continue.
The features following the two lines will run automatically because InSpec now has enough
information to construct the point and then create the system origin. After it has an origin, InSpec
knows where to look for the remaining features. The software automatically moves the stage and
places the tools at the programmed locations, collecting data for the remaining features.

Now add the other circles, the lines on the other edges, and the other arc to the end of the program.
Move the sample part to a different location on the machine and rerun the program. It should
run the same way, prompting you for the first two lines and then automatically measuring the
remaining features.
Saving the Program
Select Save or Save As from the File menu.
Give the file a name such as “Tutorial” at the File Name prompt and then click on Save.

Notice that the default directory for saving and opening a file is C:/InSpec Documents.
Select New from the File menu to start another program.

In an effort to simplify the user interface, InSpec only allows one program to be active at a time.
Tutorial will no longer be open.

Loading and Running a Program
Click on File to display the File Menu.
Select Open from the list of options.
Browse through the file listing directories to find Tutorial. Click on Tutorial and then on Open,
or double click on the file name.
The Features list and graphic will load.

Click on the Run Icon to run the program.
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Chapter 9 How to Measure Your Parts

InSpec for Windows provides a powerful metrology software package while keeping the user
interface simple. With the previous example you can see that it is easy to measure the sample part,
but now how do you measure other parts.

Considering the diversity of our customers and their parts, it is a challenge to write a “How To”
manual that will explain how to measure every part. This section provides some “typical”
measurements examples and programming tips. By applying the concepts in this chapter, you will
have a good foundation to build a program for measuring “any” part. Keep these steps in mind when
creating a part program.

¢ Plan your measurements

« Setlight levels

o Stay in focus

« Create a coordinate system
e Measure features

Planning a Program

The first step to writing a program is to identify the features that you need to and can measure with
the Micro-Vu system. Proper planning can save you time programming and running parts.

Look at the part and identify the order in which you need to take the measurements. For example,
you need to measure datum features before you can measure other features that relate to the
datum features. Also consider the order of features to minimize long moves of more that a few
inches. For example, you can measure the perimeter features of the sample part and then do a
distance between the features instead of measuring the left side followed by the right and then the
top followed by the bottom of the part.

For more advanced programs, you will want to look for easy starting points such as features that are
easy 1o locate or a way to fixture the part. Using an easy-to-locate feature or a fixture, you can write
a program that requires a single input or no input to begin automatically measuring a part.

An InSpec program will not start automatically measuring the part until an initial coordinate system
is set. This is typically created from the datum features on a part print. The initial coordinate
system information tells InSpec where the part is located on the machine and how the part is
aligned. After establishing the initial coordinate system, InSpec knows where to begin looking for
the edges of the following features. Later in the program, additional coordinate systems can be
added.

Plan your Measurements

Planning your measurements will save you programming time and shorten the overall run time of
the program. Ask yourself the following questions.

How is the part going to be held in place?... With clay? Against an ‘L’ bracket? In a fixture of
multiple parts?

How are you going to build the initial system? What features are needed to start the program? Can
you use the RefSys?

What measurement order will minimize move time between features? This is a relatively minor
issue except on large parts.

Selecting Light Levels

Lighting can have a large impact on image quality and edge definition. When selecting lighting, it is
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important to make edges appear as crisp as possible. Sharp edges will produce more repeatable
and more likely to work on the next part that may not have the same surface finish.

The best way for beginners to learn proper lighting is to look at a variety of parts and try different
lighting. The best words of advice are “Not too little, not too much” and “experiment.”

Coaxial Light or “Through the Lens Light.” In a video system, coaxial light refers to an illumination
source that is parallel to the optical axis. This is usually achieved with a right angle beam-splitter
between the lens and the camera.

Profile Light lllumination that originates from behind (under) a part directed upwards toward the
lens/camera system. This lighting technique is very good for illuminating flat parts.

Surface Light or “Ring Light.” In this application, surface light refers to illumination from above the
part. The light is reflected off the surface of the piece. Usually, surface lighting is some form of ring
light around the lens.

Creating a Coordinate System

The purpose of the initial system is to give your program a place to start. It tells the program the
location and the orientation of the part on the machine. Your initial system is the cornerstone of
your program. With a reliable initial system, your program will require few if any changes.

'S Systems are very important. If the location of the origin is incorrect, the error will be
present on any locations of features. If the skew is inaccurate, an error will be
present and increase the further a feature is located from the origin. A bulletproof
system will have a precise ORIGIN in X, Y, and Z and a precise SKEW.

A
0 Before creating the initial system, take a good look at your parts and prints. You
need to find a feature with LOCATION and a feature with ORIENTATION. These features are often
the datum features on the prints, but other features may be used.

LOCATION

The initial system needs a starting point on the part. The LOCATION feature(s) tell the program
where the part is located on the machine. This X-Y position needs to be repeatable from one part to
the next but does not have to be the same as the datum as described on the part print. Good
examples include a point at the intersection of two lines and the center of a circle. Bad examples
are the center of a line or a point on a curve.

ORIENTATION K E

The initial system needs to know how the part is aligned and in what direction the X- and Y-axis are
aligned. The ORIENTATION feature(s) tell InSpec how the part is skewed on the stage. Again, this
alignment needs to be repeatable from one part to the next but does not have to be the same as the
datum as described on the part print. Good examples include a line, which can be an edge on the
part, or a line between two holes. Any feature that has “direction” can be used.

Skew

Length Matters

When picking the features that will be used for the skew of a system, keep in mind that length does
matter. A longer line will have less angular error than a short line. For instance, a feature scan line
at low magnification will use a 0.100" segment of an edge. A deviation of less than 0.0002" in the Y
direction from end to end translates to an angular error of 0.1°. That doesn’t seem like much. But if
you now measure a hole 4" from the origin along the X-axis, you will have a 0.007" deviation in the
Y position due to the sine error.
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The deviation of less than 0.0002" over a line of 4" would produce a much better skew reference
with an angular error of less than 0.003°.

The skew of the coordinate system can have a large affect on measurements, especially of larger
parts. Skew to long lines created with multiple points to reduce errors.
Edit Skew Offset

Some parts have a datum which is offset from measured features. For these parts, there is the Edit
Skew Offset functionality which allows you to manually enter the distance.

ll o | _aned

This option is only available for system features whose skew is defined by 2 points. It is accessed
by right clicking on the system feature and choosing Edit Skew Offset. The value inputted by the
user is the perpendicular offset distance between the second skew point and the print datum.

Stay in Focus — Z-Origin

The most overlooked part of most programs is the Z-origin. If you do not include a focus point and a
Z-origin in the beginning of your programs, images may be out of focus when you measure parts.
Focus and Z-height are synonymous. When you focus, you are locating the Z-height of the part.

Focus problems are more visible when using high magnification. Because of the smaller depth of
field at high magnification, the image appears blurry when slightly out of focus. At low magnification
the depth of field is larger, and small changes in focus/Z-height appear to have little affect on the
image. However, being out of focus at any magnification reduces measurement accuracy and
produce poor repeatability.

A focus point and Z-origin should be included before datum features are established. A
focus point may be the first feature in the program or may be several features later. Later in the
manual we discuss building a bulletproof system and give an example that adds a focus point to the
system. Using a focus point and setting the Z-origin before selecting datum features provides
sharper images, hence better accuracy and repeatability, for the tools used to create datum
features.

A good program will include a focus point and Z-origin each time there is an increase of
magnification. Focus is less repeatable at low magnification than at high magnification. If | focus
on my part at low magnification and zero the origin, the part will appear to be in focus. When |
increase magnification, the image may look blurry. It is important to refocus at the high
magnification and zero the Z-origin. This will ensure that tools used at this magnification will be in
focus when the program runs even if the focus at low magnification is less repeatable.

A good program will include a focus point and Z-origin for each change of height. Many parts
will have features at different heights. From one part to the next, the heights will be different,
varying by the acceptable tolerance of the part. A part may have some features at one level and
then others on another surface an inch higher. On the first part the features may be 0.995-, on the
next they may be at 1.005'. The edges would appear out of focus. Take a focus point and set the
Z-origin. Then measured height will be used as the reference instead of the nominal height of
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1.000". The images will be in focus and accuracy and repeatability will be better.

Creating a Feature

The icons between the instruction list and the camera window are divided into three main sections.
On the left are the features. Feature icons are the types of entries that can appear in the instruction
list. To create a feature, select the icon for the feature you want.

Select from point, line, circle, arc, distance, angle, ellipse, rectangle, slot, gap, spline, o-ring, and
system.

Selecting a feature icon will place a feature in the instruction list. InSpec uses a “closed” feature
architecture that requires the feature to be completed or deleted before allowing the user to work on
another feature. You must provide enough points to construct the current line, circle, or rectangle
before you can begin the next arc, point, or distance.

As with any job, you will get better results if you use the correct tool. Using a hammer to pound
nails usually works better than using a shovel. Refer to the tool descriptions in previous chapters
for tips on choosing the correct tools.

Using Magnification

The programmable zoom lens gives the Micro-Vu system the flexibility to easily locate parts as well
as to accurately measure very small features. For the best focus repeatability, a medium to high
power (and for the zoom lens, a 2X multiplier) works well. If heights or very small features are not
necessary, most users prefer to use lower magnification so that more of the part can be seen.
Furthermore, at lower magnification, the depth of field is greater. This is can be advantageous for
edges that exhibit variation in the Z direction. Although the surface varies in Z, it will appear to be in
focus.
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Chapter 10  Application Tips

InSpec for Windows is an incredibly flexible metrology software package. It is used by customers
measuring sheet metal panels with tolerances of +/- 0.020" as well as customers measuring fiber
optic connectors with tolerances of +/- 0.000020". Parts vary in size, shape, weight, material, and
texture. The objective of the InSpec software is to provide an easy-to-use metrology solution that
meets most customers’ needs.

Considering the diversity of our customers and their parts, it is a challenge to write a “How To”
manual that will explain how to measure every part. This section provides some “typical’
measurements examples and programming tips. By applying the concepts in this chapter, you will
have a good foundation to build a program for measuring “any” part.

Making an Initial System

The following steps outline how to create a simple initial system at the bottom left corner of the
sample part. These steps provide a well defined location and orientation of the part. This example
is repeated with icons and pictures in the next section, Measuring the Sample Part.

r i
i i

Systern 4

Place the sample part on the machine.
Activate the profile lighting and click on Auto Lights.
Set the magnification to the lowest setting.

Position the stage so that you can see the bottom left corner of the part on the screen. Make
sure that the part is in focus.

Select the Line feature icon.
Select the Line tool icon.

Click in two places on the bottom edge of the part to create a horizontal line.
This will create feature Line 1.

Click in two places on the left edge of the part to create a vertical line, feature Line 2.
Select the Point feature icon.
Select the Intersect icon.

Click on Line 1 and Line 2 to create a point at the intersection of the two lines.
Now you have a Point that has a well defined LOCATION and a line that has DIRECTION.

Select the Skew icon.
Click on the horizontal line. The system will be aligned to the horizontal line.
Select the System icon.
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Select the Origin icon.
Click on the Point. The system will be “zeroed” to the point.

More Simple Programs

After you are comfortable with the steps above, read through and practice the following
programming tips.

Same Sample Part, New Origin

Because InSpec is so flexible, there are often more ways than one to locate a feature or make a
measurement. Using the Sample Part again, use the following steps to make another system with
the origin at the center of the bottom left circle and skewed to the bottom edge.

Activate the profile lighting and click on Auto Lights.

Set the magnification to the lowest setting.

Position the stage so that you can see the bottom left corner of the part on the screen.

Select the Line feature icon.

Select the Line tool icon.

Click on the bottom edge of the part in two places to create a horizontal line.

Select the Circle feature icon.

Select the Profile Circle icon.

Click at the center of the circle and then click and drag the dash circle to encompass the hole.
Select the Skew icon.

Click on the horizontal line.
The system will be aligned to the horizontal line.

Select the System icon.
Select the Origin icon.

Click on the Point.
The system will be “zeroed” to the point.

Add a few additional features and run the program.

Same System, One Feature

Using the same hole and line as above, you can create the same system with a single feature. The
only difference between this example and the previous example is the picture in the schematic. The
only feature that is actually defined in the following example is the system. Therefore, only the
system will appear in the schematic, not the original line and circle.

Activate the profile lighting and click on Auto Lights.

Set the magnification to the lowest setting.

Position the stage so that you can see the bottom left corner of the part on the screen.
Select the System icon.

Select the Skew icon.

Select the Line tool icon.

Click on the bottom edge of the part in two places to create a horizontal line.

Select the Origin icon.

Select the Profile Circle icon.

Click at the center of the circle and then click and drag the dash circle to encompass the hole.
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Add a few additional features and run the program.

Now you have created the same system as above but with a single feature. Sometimes this is
easier for the operator to understand. Sometimes it is more difficult because the circle and line
used to establish the system are not displayed. Notice that only the system is displayed on the
schematic view of the part. This can be confusing unless user prompts are added to describe which
features were used.

Building A Bulletproof System

As mentioned earlier, coordinate systems are very important to ensure the accuracy of your
measurements. A bulletproof system will have a precise ORIGIN in X, Y, and Z and a precise
SKEW.

To build a bulletproof system, you can start with a rough initial system. Once you have an initial
system, program the features that will be used to make your final system. Start by zeroing the Z-
axis on a focus point to ensure that the following features will be in focus. Use multiple points to
define the datum features. Remember to use the entire length of a line to minimize skew errors.

InSpec does not limit the number of systems in a program. You can use a simple initial system to
get the program started. Then measure some additional features to define the system better. Then
construct a third or fourth system to represent the datum features. Remember that this is an
automated system. Have the machine and software do the work of finding features and building a
bulletproof system. This also reduces any error contributed by the operator.

Start with a Point

The next example shows that with some assumptions, you can start a program with a single manual
point.

Place the sample part on the machine aligned to the X and Y axes.
The following steps will create a system at the bottom left corner of the sample part.
Activate the profile lighting and click on Auto Lights.
Set the magnification to the lowest setting.
Position the stage so that you can see the bottom left corner of the part on the screen.
Select the System icon.
Select the Origin icon.
Click on the Manual Point tool.
Click on the corner of the sample part.
The system will be “zeroed” to the point. This is just a starting point. Even if you are off by five or
ten pixels, the program will still run.
Select the Line feature icon.
Select the Line tool icon.

Place the line tool on the bottom edge starting about half and inch (onscreen) from the corner
and about two inches long. Make the search zone at least two inches wide.

Select the Line feature icon.
Select the Line tool icon.

Place the line tool on the left edge starting about half and inch (onscreen) from the corner and
about two inches long. Make the search zone at least two inches wide.

By programming the search zones for these two lines to be wide and close to the origin, the
program is likely to find the edges even if the part is not aligned with the axes of the machine. We
assume for this program that the operator can place the part on the stage within +/- 10° of the X-Y
alignment of the stage. As long as the part is more-or-less straight on the stage, the program will
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run.
Select the Point feature icon.
Select the Intersect icon.

Click the Line 2 and Line 3 to create a point at the intersection of the two lines.
ThIS point will be a better origin than the manual point.

Select the System icon.

Select the Origin icon.

Click on Point 4.

Select the Skew icon.

Click on the horizontal line. You will have a new system. It is better but not great.
Select the Point feature icon.

Select the Focus Point tool icon.

Click on the corner of the part.

Select the System icon.

Select the Z-Origin icon.

Click on Point 6. This establishes an initial Z-plane for the part.
Select the Line feature icon.

Select the Best Edge tool icon.

Select More Inputs mode.

Place three edge tools, one near the corner, one near the center, and one near the opposite
end of the bottom edge.

Select the Line feature icon.

Place three edge tools, one near the corner, one near the center, and one near the top of the
left edge.

Select the Point feature icon.
Select the Intersect icon.

Click the Line 8 and Line 9 to create a point at the intersection of the two lines.
This point will be a better origin than the previous point.

Select the System icon.
Select the Origin icon.
Click on Point 10.

Select the Skew icon.
Click on the horizontal line.

Now you have a new system that has a well defined X-Y-Z Origin and a well defined skew. This
system is probably much more than needed. Carefully consider your coordinate system when you
are measuring parts with tight tolerances.

Z-axis position and focus are important for accurate measurements.

If measurements are taken in one plane, then you need one Point feature created near the
beginning of the program that uses a Focus Point tool. Then a system should be created and the Z-
axis origin should be set to the Point. The Z value should be very close to zero for the features that
follow.

For the best program, this should be done every time there is a change in Z position. Create a point
feature with a focus point tool and then set the Z origin to the point.
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Finding Small Features

The area that the vision tools search for the desired edge is always based upon the current
coordinate system. With this in mind, if a feature's size is comparable to the tolerance of the
feature's position, it may become difficult to reliably find the feature in an automated program. One
suggestion is to set a new coordinate system upon some larger feature that is close by the small
feature. Many times, the incremental distance between the two features is much more tightly

constrained than the distance from a far away origin. In this way, the Measuring Center" can
reliably find the larger feature and use it for zeroing in on the smaller one.

For example, if a large rectangular part has an origin in the lower left corner and located in the
upper right corner is a .050" hole with a positional tolerance of .050". Finding edges based upon the
initial origin may be difficult since the hole can move around a distance of its entire diameter. Now
suppose that the hole is much more tightly dimensioned to the upper right corner. If so, find the
vertex of the upper right corner and set a new origin at that spot. Now we should be able to reliably
find the small circle since we have “bootstrapped” off a larger (and easier to find) feature.

Parts with Concentric Features

The geometry of some parts allows the user to use some tricks. For instance, many customers
measure round parts with concentric features. Because of the geometry of the part and some
assumptions that the parts will be fairly close to the nominal values, an initial system can be created
with only an Origin. The system skew will not be important because of the symmetry of the part.

For these parts you can use a manual point at the center of the part or a tangent point line of a
circle located with one of the cross hair lines. These points are easy for the operator to identify and
can give the system enough information to locate the other features on the part.

Diameters on Tapered Parts
Measuring the diameter at a nominal distance from the end:

Example: measure the diameter 4" from the end of the part. The print calls for a 1.00" diameter
+/-0.05". Put the system at the end of the part, and skew to the centerline of the taper. Create
points at (4,1,0) and (4,-1,0) using the point offset. Create a line between the two points. Create
intersection points with the line and the top and bottom edges of the taper. Take the distance
between the two intersection points. Set the tolerance of the Y distance to be 1.00 +/-0.05".

Measuring the location where a ring gage would fit on a taper:

Example: measure where the diameter is 1". The print calls for a location of 4.00 +/- 0.01". Put the
system at the end of the taper, skew to the centerline of the taper. Create points at (3.5,0.5,0) and
(4.5,0.5,0) using the point offset. Create a line between the two points. Intersect the line with line

on the top edge of the taper. The X location of the point is the location of the 1" diameter.

Set the tolerance of the X position to be 4.00 +/-0.01".

Optimizing Programs for Speed

There are many ways to optimize inspection programs for speed. A major way is by the use of drive
points. By using drive points, all of the vision tools which fit within a snapshot can be measured at
the same time. The effect of drive points can be enhanced by using low magnification, and by using
vision tools with small search zones. Drive points can be applied automatically or manually.

Auto Generate Drive Points

This function will look at all of the vision tools that are used in a program and group them based on
proximity. When the program is run, multiple features will be measured at the same time —
eliminating the time spent driving to the center of each vision tool. To use this function go to the
Tools menu and choose 'Auto Generate Drive Points'.
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Auto Generate Drive Points. = ]
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A dialog box lets you pick whether you want to apply the drive points to all features or just selected
features. Another dialog shows the reduced number of snapshots and the time reduction.

Manually Setting Drive Points

The 'Auto Generate Drive Points' function does not group together features which have different
parent systems. For features which can be measured in one field of view, but have different parent
systems, use a manual drive point. Do this by selecting all of the features that can be measured
with a single snapshot, right click and choose 'Set Drive Point'.

Reduce Setting Changes

Each time the machine changes from high magnification to low magnification it takes approximately
5 seconds. By thinking ahead and grouping features which are measured at the same
magnification, you can avoid time lost by changing zoom frequently.

Likewise, it takes a few seconds when you change between using vision and touch probe. Write
your program so that all of the touch probe features are taken sequentially, without repeatedly
changing back to vision.

Fixturing

Using a fixture for your part will help inspectors start programs more quickly. To best take
advantage of a fixture, use a stored system which remembers the measurements of the fixture.
More information on this is located in the Stored Features section of Chapter 14.

Notes

For complicated setup procedures, you can write notes detailing how the inspector should begin the
program. The notes can be incorporated in InSpec via a text feature or a prompt. A prompt feature
will stop the program until the operator has acknowledged it (by hitting enter or clicking 'OK"). A text
feature will not stop the program, but will not be visible unless the operator clicks on the feature.

file:///C:/Users/hihi/AppData/Local/Temp/~hh60A .htm 5/2/2018



Chapter 11 Setting Feature Tolerances Page 1 of 5

Chapter 11 Setting Feature Tolerances

With InSpec you can set bilateral, form, true position, and profile tolerances, including tolerances
using reference features. Once values have been entered, InSpec will display a green check mark
or a red “X” in the feature summary window to indicate that the feature is in tolerance or not.

Tolerances can be applied to a single feature or to a block of features.

InSpec allows feature tolerances to be added to individual features in your programs. In a single
dialog box, InSpec will display the pertinent information of the selected feature with regards to the
tolerances.
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If a block of features is selected, the dialog will display the pertinent information for the selected
feature type indicated in the top left of the box.

Types of Tolerances

%Bilaterals

Bilateral tolerances include basic size and location tolerances.

%Position RFS

Nominal values define the location of a feature. The true position RFS sets a diametric tolerance
zone for the position of the feature. The tolerance is independent of size of the feature.

M p o sition MMC

Nominal values define the location of a feature. The true position MMC sets a diametric tolerance
zone that increases as the feature deviates from its maximum material condition. The tolerance is
dependent on the size of the feature.

YPosition LMC

Nominal values define the location of a feature. The true position LMC sets a diametric tolerance
zone that increases as the feature deviates from its least material condition. The tolerance is
dependent on the size of the feature.

=
%Straig htness
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Straightness is a form tolerance with the condition that the element of a surface or an axis is a
straight line. The tolerance is determined by placing a zone about the line where all the points must
lie.

@Circularity

Circularity is a form tolerance with the condition that all the points lie equidistant from a center (used
to determine how round a circle is). The tolerance is determined by placing two concentric circles
about the center where all the points must lie.

=
ﬁFIatness

Flatness is a form tolerance where the surface has all points in one plane. The tolerance is
determined by placing two parallel planes about the desired plane where all points must lie.

%Perpendicularity

Perpendicularity is an orientation tolerance with the condition that a surface, plane, or axis is at a
right angle to another. The tolerance is determined by two parallel lines constructed perpendicular
to a datum or an axis. The data points must lie between the constructed lines. The gap distance
between the constructed lines is the perpendicularity value.

%Parallelism
Parallelism is an orientation tolerance with the condition that a surface, plane, or axis is equidistant
at all point to another. The tolerance is determined by two parallel lines constructed parallel to a

datum or an axis. The data points must lie between the constructed lines. The gap distance
between the constructed lines is the parallelism value.

;ﬁAngularity

Angularity is an orientation tolerance with the condition that a surface, center plane, or an axis is at
a specified angle from a datum plane or axis. The tolerance is determined by two parallel lines
constructed at the specified angle relative to a datum or an axis. The data points must lie between
the constructed lines. The gap distance between the constructed lines is the angularity value.

-Concentricity

Concentricity is where all the data points are congruent about an axis or another feature. The
tolerance is determined by placing a circle about the axis or the center of a feature where all of the
data points of the second feature must lie. In other words, it tells how close are the centers of two
features.

. .::"Profile of a Line

Profile of a line establishes a two-dimensional tolerance zone around a nominal feature. The value
of this bilateral tolerance is determined by doubling the distance from the nominal feature to the
maximum data point. Nominal values for the feature must be entered. The current system acts as
the datum references. If there are no datum references, create the feature, set a system origin on
the feature, create duplicate feature, and tolerance the duplicate feature.

Fameree

= Profile of a Surface

ER

Profile of a Surface establishes a three -dimensional tolerance zone around a nominal feature. The
value of this bilateral tolerance is determined by doubling the distance from the nominal feature to
the maximum data point. Nominal values must be entered for the feature. The current system acts
as the datum references.
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Cai

Circular Run-out is a two-dimensional tolerance zone defined by the minimum and maximum
distances of a feature surface to a reference point. This tolerance applies to circles and arcs. The
Run-out value reflects the form of the feature as well as the eccentricity of the feature to the
reference point.

Circular Run-out

” Total Run-out

Total Run-out is a three-dimensional tolerance zone defined by the minimum and maximum points
of a feature surface to a reference axis of rotation. This tolerance applies to cylinders and cones.
The Run-out value reflects the form of the feature as well as the eccentricity of the feature to the
reference axis.

Entering Tolerances

If the feature is not already selected, select the feature you wish to tolerance from the Features list
or from the Schematic window.

Next, right click with the mouse and select Tolerances from the options.

The Feature Tolerances dialog box will display the feature’s bilateral tolerances. Bilateral
tolerances are the basic position and size characteristics of the feature.

You may enter values in the Nominal and tolerance columns. These cells will normally have a white
background. However, if the characteristic is out of tolerance, the cell will have a red background.
The values in the other columns are computed and cannot be edited.

Entering Form Tolerances

Form tolerances include circularity, flatness, and straightness.

First, if the feature is not already selected, select the feature you wish to tolerance from the
Schematic window.

Next, you will need to bring up the appropriate Form Tolerance dialog. This can be achieved by
either clicking on the desired form tolerance button from the Tolerance Tool Bar or by selecting the
desired form tolerance from the Tolerance menu from the Features Context Menu.

The following is a Form Dialog (Circularity):

Pesburs byps:

{@ ok =

t |4 |sclesw O |G || ~|
e X

Actual; Tobsranoa: Deetshion;
T 0200 [ Haosns0

Use the tab key or the mouse to maneuver around the dialog.
Feature Type — Displays the feature being toleranced.
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Actual — Displays the measured values.
Tolerance — The tolerance zone.
Deviation — Displays the difference between the Actual and the Nominal.
If you are applying the tolerance to a group of circles, the Actual value will remain blank. If multiple
values already exist, question marks, “???”, will appear in the tolerance box.
Entering True Position Tolerances
True Position tolerances include RFS, MMC, and LMC.

After you select the feature(s) you wish to tolerance, select Tolerances... from the Features
Context Menu.

Select the appropriate positional tolerance from the tabs in the Tolerance Dialog Box.

t|e #0s| 0 |G|~ 2|
Trus Pasition (LMC) [:ﬁ, el
Kokt Deveskion:
315‘3 [ oEmmE | oo
Wi | se0eosst | | sonecond | O-DOSSY et it
Tsmstert S0 | e0o mOOLH | ooism | Golsoo

Tul:rm I'I':I + Bonigsl  EFfecties

n4s | oosoon | Goiaes | D666 | -nogeaT

Dhasbestn B siurs:

st |

For TP MMC and TP LMC a bonus will be calculated and applied during the evaluation.

The following is the dialog for TP MMC for a single feature:

Use the tab key or the mouse to maneuver around the dialog.
Icons — Use the icons on the right to specify it the feature is a hole or boss.
Actual — Displays the measured values.
Nominal — Displays the nominal value. This number must be entered.
Deviation — Displays the difference between the Actual and the Nominal.
Deviation from Nominal — The true location from nominal based on a diametrical zone.
Tolerance — The tolerance zone.
Bonus — An increase in the tolerance based on the feature departing from its MMC size.
Effective (Tolerance + Bonus) — The effective tolerance zone considering the bonus.
Deviation from effective — How far off the hole or boss is from the Effective Tolerance Zone.

In addition to its LMC or MMC bonus, a feature can have a datum bonus applied to its tolerance. If
the datum of a feature has a LMC or MMC tolerance, the bonus from the datum can also be added
to the effective tolerance of the feature. When you click on the Datum Bonus icon, the following
window appears:
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Fill in information as you did for the LMC and MMC scenarios above. When you click OK the bonus
will automatically apply to the feature tolerance.

Tolerances the require Reference Features

Some ANSI Y14.5 tolerances, including angularity, concentricity, perpendicularity, and parallelism,
are dependent upon a datum feature. For these tolerances, an additional combo box will appear

allowing you to select the reference feature.
Following is an example for concentricity using circle 3 as the reference feature.

Feature Tolerances - Chrch DD

Feabars bype:

fagde -
t |4 |sclew| 0 @ || 2|
S ad

Rafarence Fashone:

| & ek 3 bl

Actual Toberance! Dervlation:
I oaee | 0.5

You can use the tab key or the mouse to maneuver around the dialog.

Feature Type — Displays the feature type being toleranced. If you have selected multiple
feature types, use the pull-down box to switch feature types.

Reference Feature — Displays the feature being referenced to determine the tolerance.
Actual — Displays the measured value.

Tolerance — Displays the nominal value. This number must be entered.

Deviation — Displays the difference between the Actual and Tolerance.
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Chapter 12  Exporting Data

Each measured feature type has six or more exportable properties. A distance as seen below has
seven properties. In addition, you can export the Nominal & Tolerances and Labels for each
property. InSpec allows you to select individual export properties for each feature and save.

Feature Exports
The Feature Exports dialog boxes have been designed to be simple to use and understand.

Setting export properties for features can be performed on an individual feature or a group of
features. To setup the properties to be exported for a single feature, right click on a feature and
select Exports from the Features List context menu.

A dialog box similar to the one below will be displayed with the feature name at the top.

Feature Exports - Distance 12 il |

Featune e ¥ Expart Nominals & Tolerances
Eﬁ» Distancea j [+ Export Labels

i Export Property? Label
|~ Directicn '

[ pitch

E.].\T.[.)i'staﬁce X D){
|7 Distance ¥ D
:r».? Distance £ [z
|~ Distance x¥ '

[~ Distance %z

(I Distance vz

fr'Disfa’u:é WVZ

| ¥ Date/Tims

Export Nominals & Tolerances — This option will automatically include tolerance information if
available for each of the selected properties.

Export with Label — This option allows the user to include labels with exported data. The
default label is the feature name followed by the property, the whole label is in quotes, i.e. “Circle 1:
Center X”.

Export Property — Click on the check boxes to specify which properties are to be exported.

Label — These cells are used to create custom labels for each export property. If Export
Labels is checked and the Export Property is checked, InSpec will check for and export the custom
label with the property’s value. If a custom label is not entered, the default label will be exported.

Multiple Feature Exports

Export properties can be set for a block of features. After selecting multiple features in the Features
list, right click on a selected feature and select Exports. This will display the Multiple Selection
dialog box.
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Feature Exports - Multiple Selection. X
Feature bpe: ™ Esport Nominals & Tolerances
Inopenspine =] & Eparttabels

@ Circle
d=b Distance g Label

MCS20

Close |

There are two differences between the individual and multiple selection dialog boxes. First, the
dialog box header changes to indicate that you have selected multiple features.

Second, InSpec displays a drop down list under Feature Type when a group of features with
different feature types has been selected. InSpec separates the feature types for you, so you can
assign the appropriate export properties.

For example, you may have a program with a mixture of points, lines, and circles, but you are only
interested in the diameters of the holes. You can select all the features in you feature list (Ctrl+A),
right click and select Exports, choose Circle from the Feature Type drop down menu, and then
check the Diameter box. Now all of the diameters are ready to be exported.

Export Configuration

InSpec allows you to manually or automatically export data. To export automatically, please see the
Export File Parameters and the Serial Export Parameters sections in Chapter 13.

To manually send data to a file or port, select Export under the File menu.

G File:  |ciymydatsidats_hokes. tit ]
W append to existing filke
" Serial Port (COMI) Bt 1 =R e

For matting

W Use Run Separators
I Unicode Text Encoding
I™ Compatible with InSpec 1.x

—Eield Delimiter 5 —RBecord Delimiter
" Space " Spame
= Tab " Tah
" Comma " Comma
T Mew Line & Mew Line

ok | Cancel
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Setting the Export Destination

With the manual export, you can send data to a file or a data port. Use the File or Serial Port radio
buttons to make your selection.

When exporting to a file, you must enter a data file name and location. Use the button with three
dots to browse through directories. Check the Append to Existing File if you want to add data to
the end of an existing file. If the box is not checked, InSpec will replace existing data with new data.

When exporting to a Serial Port, the Configure Port button will become active and allow you to
adjust port settings.

Formatting

Run Separators — This toggle enables :BEGIN and :END markers to be included with the
export data.

Unicode Text Encoding — If you want to export text, prompts, or labels that contain Unicode
characters, you must check this box. This setting will be helpful if you are not using the US-English
character set.

Compatible with InSpec 1.XX — The export order of some tolerance fields has changed since
InSpec Version 1.XX. Check this option to use the order used in 1.XX. The different orders are
shown in Appendix A.

Delimiter

. Field Delimiter — Select the separation character to go between feature data. (Line 1 data [,]
Arc 2 data [,] Circle 3data [] ...)

. Record Delimiter — Select the separation character to go between feature property data. (Arc
2:Center X [,] Arc 2:Center Y [,] Arc 2;Diameter [,] ...)

For automatic reporting using Playback Options ... under the Tools menu, refer to the section on
Automated Reporting for more information.

Output Format

The different types of tolerances have different fields to export. The typical order for data is [Label]
Actual, [Nominal, PlusTol, MinusTol, DevNom, DevTol].

The Label is optional and must be checked in the Feature Exports dialog to be exported. Exporting
the nominal and tolerances is also an option in the Feature Exports dialog. Samples are shown in
Appendix A.

Part Separators

The part separator is a special feature type used to format your data. It exports a Carriage Return
and Line Feed (CR/LF) when it is reached in a program. This can help manage exported data for a
program that measures multiple parts. Select Insert from the Feature menu, and then select Part
Separator to insert a new Part Separator feature into the part program.

The part separator is commonly used when multiple parts are being measured in a single part
program. To see why this is useful, let's imagine that 5 paper clips are placed in a row in a fixture.
Measure some arcs and distances on the first paper clip. Set the radii and distances to export using
comma or tab delimiters. Use Translate to make 4 copies of the first clip. Now export the results to
a file. When exported, the data for the five clips would be strung together on a single line. This can
be difficult to handle.

By adding a part separator at the end of the measurements for each clip, the data for each part will
be on a separate line. With each part's data on a separate line, it is easier to import the data into
SPC and other software.
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Chapter 13  Playback Options

InSpec does more than measure parts and display data. It provides options to automatically print,
save, and transmit data. Tool and tolerance “failure” modes can also be activated. These tasks
and settings can be saved with each program.

These options are accessed from Playback Options... under the Tools menu.

Export File | Sxport to Serial Port | Privt Report | Faitures |

Export
" Drisabihed o After Run
O Durrg Bun O After Bun (Condirne

File Marme:
data_holes. b ._..-J

Formatting
¥ Uge Bun Separators
[~ Unicode Test Encoding
™ Cormpatibhe with TrSoec 1.4

—Eieki Delimiter - 1 -Epcord Defimiter -
" Space " Spare
™ Tab I~ Tab
& Comma ™ Comma
™ Mew Ling & Hew Line

Cancel

Export File Parameters

After properties of the features have been selected for exporting, you are ready to send the data to
a file. The export file will be a text file (*.txt).

Manual exporting can be performed by selecting Export from the File menu.

Automatic Exporting can be performed by selected Playback Options ... from the Tools menu.
The dialog box above will appear. Automatic Exporting appends data to the end of the designated
file every time the program is run.

Export— Use the radio buttons to select when you want the data exported, “Disabled” (off, no
export), “During Run”, “After Run”, and “After Run Confirm”. “During Run” sends data as each
feature is measured. This can help when an SPC program is monitoring the data file. “After Run”
waits until all features are measured, and “Confirm”will prompt the user before sending data.

File — Enter a data file name and location. Use the button with three dots to browse through
directories. If an existing file is selected, data is automatically appended to the end of file.
Formatting

Run Separators — This toggle enables “:BEGIN” and “:END” markers to be included with the
export data.

Unicode Text Encoding — If you want to export text, prompts, or labels that contain Unicode
characters, you must check this box. This setting will be helpful if you are not using the US-English
character set.

Compatible with InSpec 1.xx — The export order of some tolerance fields has changed since

file:///C:/Users/hihi/AppData/Local/Temp/~hhCA25.htm 5/2/2018



Chapter 13 Playback Options Page 2 of 5

InSpec Version 1.xx. Check this option to use the order used in 1.xx. Refer to the appendix for
examples of 1.xx and 2.xx outputs.

Delimiter

Field Delimiter — Select the separation character to go between feature data. (Line 1 data [,]
Arc 2 data [,] Circle 3 data[] ...)

Record Delimiter — Select the separation character to go between feature property data. (Arc
2:Center X [,] Arc 2:Center Y [,] Arc 2;Diameter [,] ...)

The export delimiter types set in this dialog are applied for both the manual and automatic export.

Serial Export Parameters

Exporting data to a serial port requires the same options as described for exporting to a file.

Playback Options k3

Export File Export 1o Serial Port | prict Report | Faitures |

Export
" Digabihed  After Run
& Drrag Bun O After Run (Condirnt

Serial Port: COML Configure Port...

Feematting
™ Use Bun Separators
[~ Unicods Text Encoding
[ Cormpatibhe with TrSges 1.k

—Eiekd Delimiter - 1 —Eecord Defimiter -
1~ Space ™ Snaoe
 Tab © Tab
&+ Comma I Comma
ok cancel |

However there is an additional button to configure the serial port settings.
L —
Lanniect Lsing! |':IT*-11 :1 :-. ok I
it per 2econd; = -i Cancel
Eats bim: b3 -]

Shop bits: 1 "ri
Bariy Ore =

Printing a Report

Printing can be automated at the end of each program or at any time by selecting Print from the File
menu. There are four options regarding which data to print: All Features, Toleranced Features, Out
of Tolerance Features, or Features marked for Export.

Each report has a header that gives the program title, date and time, units, and column headings.
The page number will be printed at the bottom of the page.
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Export Fie | Export to Serial Fort | Export Snapshate Print Repcet | raihass |

Playback Dptions

_R.mt
" Disabled
% Aftes Bun
™ after Run (Confim)
" Erint dl Features
' Brint toleranced Features
& Prok toleranced Features with Promgts.
" Brink out of tolerance Features
£ Brink out of tolerance Features with Prompts
£ Frink eiports

R Prmk with Schemistc

Printar:
[Vipeaches\QA-HLSZS0DR-FCL =]

x|

Print all Features will print all of the features in the following format:

Selecting Print toleranced Features will only print those features that have toleranced

characteristics in the following format:
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Selecting Print out of tolerance Features will only print those features that are out of tolerance, in
the following format:
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The Print Exports option will use the same format. It will only print feature properties that are
marked for export.

Another Print option under the File menu is Print Schematic. This option will print the features (and
Tags if present) in the Schematic Window. It is useful to display tags and print the Schematic to
help document inspection procedures.

Handling Failures

The Tool Failure Mode and Tolerance Failure Mode each provide three options: stop, wait for the
user, and continue. These options can save you time measuring parts.

For instance, use the “skip and continue” tool failure mode if you need to leave the machine
unattended. InSpec will run the entire program and allow you to fix “failed” tools when you return.
InSpec will check to see if the feature is needed to create a system. If it is, the InSpec will
automatically pause and wait for the user.

If the user will be monitoring the system while running the program, it is best to use the “pause and
wait for user” tool fail mode.

The “stop the program” tolerance failure mode can be used to stop after the first out of tolerance
measurement. The operator can go to the next part without spending additional time on a rejected
part.
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Chapter 14  Advanced Features

InSpec for Windows includes advanced features that allow parts to be measured without user input,
reports to be generated automatically, and displayed measurements to be customized.

Stored Features

InSpec software allows features to be stored in memory. Once stored, they can be used in other
programs. Stored features can be used to save the position of a fixture. The position of the fixture
can then be used to start your part program. With a known initial coordinate system, the part
program will run automatically after an operator presses the run button.

Storing a Feature is very simple. Create a system from measured features. Select the system that
you want to store and choose Store Feature from the Features Context Menu. The following dialog
will appear:

Check the box next to Store As and enter a unique name. The name can be any combination of
letters and numbers. Unless the Save Permanently box is checked, the feature will only be saved
for the current session of InSpec and will be lost when the software is closed. If saved permanently,
the feature will remain until manually removed via Tools — Stored Features.

Using a Stored Feature

Once a feature has been stored, it can be recalled as an input for another feature.

Select a feature icon such as a System.

i)
Select the Recall icon J

The following Dialog will appear with a list of available stored features.

L e o |
_J— Dratusinn 4
L nstum B _c.aij

L Feture 1

Select a stored feature with a double click on the stored feature’s name or with one click on the
stored feature’s name and a second on OK.

In most cases, Stored features are used as a coordinate system at the beginning of a program. For
example, suppose you have the corner of a fixture saved as an external angle called “FX1.” The
first step in your program might be to set a system origin (X, Y, and Z) to a Stored feature. By doing
s0, you automatically have your initial coordinate system measured when you load the program.

What Happens During the Run Mode?

In the run mode, when InSpec encounters a feature that uses a stored feature as input, InSpec
checks the memory for a measured feature with that name. If the feature exists, InSpec simply
uses that stored feature’s data to create the new feature. If the Stored feature is not found in
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memory, InSpec will not run the program. Therefore it is important to permanently save features
that are used often.
Clearing Stored Features from memory

If you want to clear existing Stored Features from memory, from the Tools Menu choose Stored
Features. The following dialog will appear:

L Rafsys [ cloee
Cialate

_L Cuakien B

L Foshure 8 Leiete A

You will have the options to Close the dialog box, delete a stored feature, or Delete all of the stored
features. RefSys will appear in the list and cannot be removed.

REFSYS Home Position

REFSYS is a stored feature with an origin at the lower front left corner of the stage volume and
skew of the X axis. This entry will always be present in the Recall Feature dialog box.

REFSYS can be used to make programs run without any operator inputs. This works best with a
fixture that is permanently attached to the stage or a fixture that is removable but is always attached
in the same location. A fixture may be as simple as an “L” bracket bolted or glued to the front left
corner of the stage. The key to using REFSYS is that the location of a part in a fixture on the stage
will always be the same relative to the home position.

To use REFSYS in a program, start a new program with a system and recall REFSYS from the list
of stored features. Then begin a part program.

Start with features that define the part coordinate system, set a system skew and origin for the part
and then add a few other features. When you run the program, InSpec should drive to the features
and make the measurements without any user input.

REFSYS is also useful for taking quick measurements on a part that is not fixtured. You can rerun
the program while the part is in the same location. You can use REFSYS in conjunction with cycle
to check repeatability of focus points or edge tools on a particular material or surface.

Cycling a Program

The Cycle option under the Playback Menu is similar to the Run playback icon. However, Cycle will
continue to rerun a program for a fixed number of runs or indefinitely. This can be useful for running
several of the same part in a single fixture, gathering repeatability data when used with auto-export,
and for demonstrating to customers and suppliers.

After writing a program, simply select Cycle from the Program Menu. Select the number of time to
run the program, or select indefinite to run the program continuously. At any, time the program may
be interrupted with the Stop button. Programs beginning with a stored feature or REFSYS will cycle
without any user input. Other programs will require the user to manually measure the features
required to establish the initial system at the beginning of each cycle.

Cyche Part-Program
~Mumber af eycles
1 Froad: 1] 3,
" Epdefinite
ok | cace |

file:///C:/Users/hihi/AppData/Local/Temp/~hh70F .htm 5/2/2018



Chapter 14 Advanced Features Page 3 of 9

Center Tools on Measurements

This function automatically moves all of the search zones in the program so that they are centered
on the measured data. This makes the best use of the search area and minimizes the chance that
a tool will fail on future parts. This also allows you to use smaller search zones and cut down on
processing time. To access this function go to the Tools menu and choose 'Center Tools on
Measurements'.

Importing CAD Files

InSpec for Windows is capable of importing DXF, Excellon, IGES, and Gerber format files. These
formats are the most popular CAD file types and most CAD programs can export in one of these
formats. (Note: Import translators are optional and may not be included. Contact your local dealer
for assistance.)

Features in the CAD files are loaded and converted to features in an InSpec file. InSpec allows the
operator to create an origin from the imported unmeasured features and then “convert to initial
system.” After setting appropriate lighting and magnification, InSpec will “convert import inputs” to
automatically create tools for all of the features. In less than a minute you can create a program.

Importing a DXF File

The import process is very similar for all file types. Here is an example DXF file from the sample
part in the InSpec for Windows directory.

The Import process begins with opening a CAD file. After the user specifies conversion units, the
features in the file are converted to InSpec features. The operator creates an initial coordinate
system, and then sets the zoom and lighting. Then the part is ready to be measured.

To begin, select Import from the File menu.

You will be prompted to enter the name of the import file. Near the bottom of the dialog box you can
select the file type, DXF, Excellon, etc., you are about to import.

oo 2=
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Select the file you would like to import and click on Open.

After you have selected the import file, you will be prompted to select the scale factor of the CAD file
and the linear and angular units. The default dimension factor is one, i.e. a one to one scale factor.
The default angular units are degrees.

Select Units for Duf File =

— Y
Dimarator: | | 3 mm: = Inch

Anguler: ¥ Dagrees.  Radens T Gradians

cancel |

Select the correct units for the CAD file, and click on OK.
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At this point, InSpec for Windows will convert each of the CAD file features into InSpec features. A
list of the features will be displayed and a diagram of the part will be drawn in the schematic
window.

The next step in the conversion process is to set up an initial system for the part using features from
the CAD file. In many cases, you will intersect two lines to create a point. The point will become
system origin (0,0,0) and one of the lines will be used for the system skew alignment.

Create a system from the imported file

In this example, create a point at the intersection of the left vertical line and the bottom horizontal
line. Set the X-Y-Z Origin on the point. Set the Skew to the bottom horizontal line. The new
system will be used as the initial system for the program.

After creating the system, select the Continue button in the Import — System Construction
message box.

Corstruct & ystem from importad Fagtures,

newt | [ Canaal |

InSpec will make copies of the features used to create the initial system, in this case two lines, and
a point, and place them at the beginning of the program list. Line 1, Line 2, and Point 1 in this
example create the new initial system, System 2.

Set the light and zoom settings for your part.

The light and zoom you choose will be used for all of the CAD features after they are converted in
the next step. After you run the program, you will be able to change the lighting and zoom for
individual points.

InSpec will create the individual tools for each feature. If you look at the current inputs of the CAD
features, you will see "IMPORT" instead of a Best Edge, First Edge, or Feature Scan tool. The Tool
Create step will add 3 Best Edge points to each CAD line and 4 Best edge points to each circle or
arc. If the CAD feature can fit in the field of view, the appropriate Feature Scan tool will be used.

Tripuatt - Tood Creakion
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After selecting Finish, the tools will be applied to the features. The features will not have data
indicating that they are unmeasured. The file conversion is complete and you can now run the
program.

At this point the program is just like any other that you have created. You can add and delete
features. You can edit and save the program. You can verify that the program has been imported
properly by viewing tolerances. The tolerance dialog box will show the nominal locations of
features. These numbers should match the number in the DXF file.

Run the program.

To playback the program, click on the Run button.

You will be prompted to measure the features used to create the initial coordinate system. It is
helpful to turn on tags for initial features to help the user locate the initial features.

After measuring the initial features, InSpec will be able to create the initial system and measure the
other features automatically. It is important to watch the program the first time through to make sure
that the lighting, tool sizes, and zoom are appropriate. Adjust tools, magnification, and lighting as
needed.
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Exporting DXF Files

InSpec for Windows currently allows the user to export DXF format files. DXF is a popular CAD file
type that most CAD programs can accept.

The Export process begins by measuring a part with InSpec. Then, select Export DXF from the File
menu. You will be prompted to enter the name of the export file.
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Enter a file name at the prompt and click on Save. By default, InSpec will add the DXF extension to
the file name.

The coordinate system can be selected via a pull down menu which includes all the systems in the
program. If you are bringing the DXF into a CAD or bestfit software, the system which is chosen
from this menu will effect the feature coordinates.

New Program Defaults

Program defaults set parameters for NEW programs. The tabs at the top of the window divide four
sets of parameters: display, export, run failures, and temperature compensation.

Display Defaults

The system type, linear, and angular parameters are set in the display tab. Standard rounding is
used when displaying data. The Number of Digits refers to the number of places to the right of the
decimal point.

Few Program Defaults X
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Export Defaults
The export delimiter types set in this dialog are applied for both the manual and automatic export.

Formatting
Run Separators — This toggle enables :BEGIN and :END markers to be included with the
export data.

Unicode Text Encoding — If you want to export text, prompts, or labels that contain Unicode
characters, you must check this box. This setting will be helpful if you are not using the US-English
character set.

Compatible with InSpec 1.x — The export order of some tolerance fields has changed since
InSpec Version 1.x. Check this option to use the order used in 1.XX. The different orders are
shown in the appendix.

Delimiter
Field Delimiter — Select the separation character to go between feature data.

Record Delimiter — Select the separation character to go between feature property data.

x
Display  Export !Fu.n Falures | TampComg |
Configuie export formal for wew Progeams:
Farmattng
¥ Lise Aun Separators
i¥ Unicode Text Encoding
™ Compatible wih Inspec §.x

| Ejedd Dediiter — 1 - Becond Delimiter
" Space " Space
1 ol " Tab
 Cooms ¢ Eani
™ Bew Lire ™ Mew Line
o8 I Lanicel

Run Failures

Run Failures sets the conditions for stopping a program. Depending on the application and
program, the operator may want the system to run completely through the program or stop and wait
for the operator if a tool fails or a feature is out of tolerance. With long programs, it is more
convenient to allow the program to run to the end than to sit and watch for problems. The operator
can start a program and return after all features have been processed. Features that were out of
tolerance or unmeasured can then edited, updated, or fixed when the operator returns. In other
cases, it may be more convenient to have the operator monitor a long program because tools can
be immediately fixed. Or if one dimension is out of tolerance, then the operator can stop the
program, discard the bad part, and start on the next part.
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x4
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Temperature Compensation

Temperature compensation can provide the additional accuracy required for a tight tolerance or be
removed to provide a simplified interface. The settings allow a temperature feature to be added to
the beginning of each program and to request the temperature at the beginning of each run.
Consider using temperature compensation for large parts and very long programs with thousands of
features. The basic premise of any temperature compensation is that the machine, the room, and
the part have settled to equilibrium. If there are large temperature swings (>+/-2° F), then the
temperature variation will have more of an effect than the compensation.

_x,l
Dispitay | Expoet: | Biun Falres: TeinpComg |
Configure temperature settings for new Programs:
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Construction Defaults

Because Micro-Vu measurement systems are used to measure everything from precision ball
bearings and computer chips to rubber hoses and coat hangers, we have tried to make the software
powerful yet simple. The Construction Defaults give the operator a means to customize some of the
functionality. The distance between two circles can be the minimum, center-to-center, or maximum
distance. The same options are available for a circle to a line or a circle to a point. There are two
options for a line bisecting two lines, a line along the bisecting angle and its perpendicular.
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Consktruction Defsults
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Configure Summary

The characteristics in the Summary Window and printouts are controlled in Configure Summary.
These settings are saved with each program. As shown earlier in the manual, the display of
individual characteristics for each feature type may be turned on and off. Select the feature type

from the tabs at the top of the dialog. Then check the boxes of the characteristics you would like
displayed.
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Configure Audio

InSpec gives you the option to change its audio settings. If you are using the joystick and are far

away from the computer, you can run the sound through external speakers and increase the
volume.

~ Ao Device

7 b dudio

™ Internal Spesker

% Externd Spaakers

™ Both Tnkernal and External Speakers

==
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Platen

The platen is an optional accessory that raises and lowers a large piece of glass above the stage
glass. This is used to sandwich thin parts and keep them in place and flat. The platen for a
Quantum uses an air cylinder. The platen for an Excel is motorized.

Use the F8 hot key or the Open/Close Platen option under the Machine menu to operate the platen.
[ Machine Help
Cpen Platen Fa ‘

When the platen is opened, InSpec will automatically drive the machine so that the camera is at the
back of the stage. Then the platen will open. While the platen is open, stage controls will be
disabled to prevent the camera from being driven into the platen.

x4

The plater i apen Te kwer the platen and
reluin 1o position pess CLOSE.

...................

Use the Close button in the pop up dialog or the F8 hokey to close the platen. InSpec will drive the
camera back to its original position after the platen is closed.
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Chapter 14  Advanced Features

InSpec for Windows includes advanced features that allow parts to be measured without user input,
reports to be generated automatically, and displayed measurements to be customized.

Stored Features

InSpec software allows features to be stored in memory. Once stored, they can be used in other
programs. Stored features can be used to save the position of a fixture. The position of the fixture
can then be used to start your part program. With a known initial coordinate system, the part
program will run automatically after an operator presses the run button.

Storing a Feature is very simple. Create a system from measured features. Select the system that
you want to store and choose Store Feature from the Features Context Menu. The following dialog
will appear:

Check the box next to Store As and enter a unique name. The name can be any combination of
letters and numbers. Unless the Save Permanently box is checked, the feature will only be saved
for the current session of InSpec and will be lost when the software is closed. If saved permanently,
the feature will remain until manually removed via Tools — Stored Features.

Using a Stored Feature

Once a feature has been stored, it can be recalled as an input for another feature.

Select a feature icon such as a System.

i)
Select the Recall icon J

The following Dialog will appear with a list of available stored features.

L e o |
_J— Dratusinn 4
L nstum B _c.aij

L Feture 1

Select a stored feature with a double click on the stored feature’s name or with one click on the
stored feature’s name and a second on OK.

In most cases, Stored features are used as a coordinate system at the beginning of a program. For
example, suppose you have the corner of a fixture saved as an external angle called “FX1.” The
first step in your program might be to set a system origin (X, Y, and Z) to a Stored feature. By doing
s0, you automatically have your initial coordinate system measured when you load the program.

What Happens During the Run Mode?

In the run mode, when InSpec encounters a feature that uses a stored feature as input, InSpec
checks the memory for a measured feature with that name. If the feature exists, InSpec simply
uses that stored feature’s data to create the new feature. If the Stored feature is not found in
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memory, InSpec will not run the program. Therefore it is important to permanently save features
that are used often.
Clearing Stored Features from memory

If you want to clear existing Stored Features from memory, from the Tools Menu choose Stored
Features. The following dialog will appear:

L Rafsys [ cloee
Cialate

_L Cuakien B

L Foshure 8 Leiete A

You will have the options to Close the dialog box, delete a stored feature, or Delete all of the stored
features. RefSys will appear in the list and cannot be removed.

REFSYS Home Position

REFSYS is a stored feature with an origin at the lower front left corner of the stage volume and
skew of the X axis. This entry will always be present in the Recall Feature dialog box.

REFSYS can be used to make programs run without any operator inputs. This works best with a
fixture that is permanently attached to the stage or a fixture that is removable but is always attached
in the same location. A fixture may be as simple as an “L” bracket bolted or glued to the front left
corner of the stage. The key to using REFSYS is that the location of a part in a fixture on the stage
will always be the same relative to the home position.

To use REFSYS in a program, start a new program with a system and recall REFSYS from the list
of stored features. Then begin a part program.

Start with features that define the part coordinate system, set a system skew and origin for the part
and then add a few other features. When you run the program, InSpec should drive to the features
and make the measurements without any user input.

REFSYS is also useful for taking quick measurements on a part that is not fixtured. You can rerun
the program while the part is in the same location. You can use REFSYS in conjunction with cycle
to check repeatability of focus points or edge tools on a particular material or surface.

Cycling a Program

The Cycle option under the Playback Menu is similar to the Run playback icon. However, Cycle will
continue to rerun a program for a fixed number of runs or indefinitely. This can be useful for running
several of the same part in a single fixture, gathering repeatability data when used with auto-export,
and for demonstrating to customers and suppliers.

After writing a program, simply select Cycle from the Program Menu. Select the number of time to
run the program, or select indefinite to run the program continuously. At any, time the program may
be interrupted with the Stop button. Programs beginning with a stored feature or REFSYS will cycle
without any user input. Other programs will require the user to manually measure the features
required to establish the initial system at the beginning of each cycle.

Cyche Part-Program
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Center Tools on Measurements

This function automatically moves all of the search zones in the program so that they are centered
on the measured data. This makes the best use of the search area and minimizes the chance that
a tool will fail on future parts. This also allows you to use smaller search zones and cut down on
processing time. To access this function go to the Tools menu and choose 'Center Tools on
Measurements'.

Importing CAD Files

InSpec for Windows is capable of importing DXF, Excellon, IGES, and Gerber format files. These
formats are the most popular CAD file types and most CAD programs can export in one of these
formats. (Note: Import translators are optional and may not be included. Contact your local dealer
for assistance.)

Features in the CAD files are loaded and converted to features in an InSpec file. InSpec allows the
operator to create an origin from the imported unmeasured features and then “convert to initial
system.” After setting appropriate lighting and magnification, InSpec will “convert import inputs” to
automatically create tools for all of the features. In less than a minute you can create a program.

Importing a DXF File

The import process is very similar for all file types. Here is an example DXF file from the sample
part in the InSpec for Windows directory.

The Import process begins with opening a CAD file. After the user specifies conversion units, the
features in the file are converted to InSpec features. The operator creates an initial coordinate
system, and then sets the zoom and lighting. Then the part is ready to be measured.

To begin, select Import from the File menu.

You will be prompted to enter the name of the import file. Near the bottom of the dialog box you can
select the file type, DXF, Excellon, etc., you are about to import.
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Select the file you would like to import and click on Open.

After you have selected the import file, you will be prompted to select the scale factor of the CAD file
and the linear and angular units. The default dimension factor is one, i.e. a one to one scale factor.
The default angular units are degrees.

Select Units for Duf File =
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Select the correct units for the CAD file, and click on OK.
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At this point, InSpec for Windows will convert each of the CAD file features into InSpec features. A
list of the features will be displayed and a diagram of the part will be drawn in the schematic
window.

The next step in the conversion process is to set up an initial system for the part using features from
the CAD file. In many cases, you will intersect two lines to create a point. The point will become
system origin (0,0,0) and one of the lines will be used for the system skew alignment.

Create a system from the imported file

In this example, create a point at the intersection of the left vertical line and the bottom horizontal
line. Set the X-Y-Z Origin on the point. Set the Skew to the bottom horizontal line. The new
system will be used as the initial system for the program.

After creating the system, select the Continue button in the Import — System Construction
message box.

Corstruct & ystem from importad Fagtures,

newt | [ Canaal |

InSpec will make copies of the features used to create the initial system, in this case two lines, and
a point, and place them at the beginning of the program list. Line 1, Line 2, and Point 1 in this
example create the new initial system, System 2.

Set the light and zoom settings for your part.

The light and zoom you choose will be used for all of the CAD features after they are converted in
the next step. After you run the program, you will be able to change the lighting and zoom for
individual points.

InSpec will create the individual tools for each feature. If you look at the current inputs of the CAD
features, you will see "IMPORT" instead of a Best Edge, First Edge, or Feature Scan tool. The Tool
Create step will add 3 Best Edge points to each CAD line and 4 Best edge points to each circle or
arc. If the CAD feature can fit in the field of view, the appropriate Feature Scan tool will be used.
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After selecting Finish, the tools will be applied to the features. The features will not have data
indicating that they are unmeasured. The file conversion is complete and you can now run the
program.

At this point the program is just like any other that you have created. You can add and delete
features. You can edit and save the program. You can verify that the program has been imported
properly by viewing tolerances. The tolerance dialog box will show the nominal locations of
features. These numbers should match the number in the DXF file.

Run the program.

To playback the program, click on the Run button.

You will be prompted to measure the features used to create the initial coordinate system. It is
helpful to turn on tags for initial features to help the user locate the initial features.

After measuring the initial features, InSpec will be able to create the initial system and measure the
other features automatically. It is important to watch the program the first time through to make sure
that the lighting, tool sizes, and zoom are appropriate. Adjust tools, magnification, and lighting as
needed.
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Exporting DXF Files

InSpec for Windows currently allows the user to export DXF format files. DXF is a popular CAD file
type that most CAD programs can accept.

The Export process begins by measuring a part with InSpec. Then, select Export DXF from the File
menu. You will be prompted to enter the name of the export file.
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Enter a file name at the prompt and click on Save. By default, InSpec will add the DXF extension to
the file name.

The coordinate system can be selected via a pull down menu which includes all the systems in the
program. If you are bringing the DXF into a CAD or bestfit software, the system which is chosen
from this menu will effect the feature coordinates.

New Program Defaults

Program defaults set parameters for NEW programs. The tabs at the top of the window divide four
sets of parameters: display, export, run failures, and temperature compensation.

Display Defaults

The system type, linear, and angular parameters are set in the display tab. Standard rounding is
used when displaying data. The Number of Digits refers to the number of places to the right of the
decimal point.
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Export Defaults
The export delimiter types set in this dialog are applied for both the manual and automatic export.

Formatting
Run Separators — This toggle enables :BEGIN and :END markers to be included with the
export data.

Unicode Text Encoding — If you want to export text, prompts, or labels that contain Unicode
characters, you must check this box. This setting will be helpful if you are not using the US-English
character set.

Compatible with InSpec 1.x — The export order of some tolerance fields has changed since
InSpec Version 1.x. Check this option to use the order used in 1.XX. The different orders are
shown in the appendix.

Delimiter
Field Delimiter — Select the separation character to go between feature data.

Record Delimiter — Select the separation character to go between feature property data.
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Run Failures

Run Failures sets the conditions for stopping a program. Depending on the application and
program, the operator may want the system to run completely through the program or stop and wait
for the operator if a tool fails or a feature is out of tolerance. With long programs, it is more
convenient to allow the program to run to the end than to sit and watch for problems. The operator
can start a program and return after all features have been processed. Features that were out of
tolerance or unmeasured can then edited, updated, or fixed when the operator returns. In other
cases, it may be more convenient to have the operator monitor a long program because tools can
be immediately fixed. Or if one dimension is out of tolerance, then the operator can stop the
program, discard the bad part, and start on the next part.
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Temperature Compensation

Temperature compensation can provide the additional accuracy required for a tight tolerance or be
removed to provide a simplified interface. The settings allow a temperature feature to be added to
the beginning of each program and to request the temperature at the beginning of each run.
Consider using temperature compensation for large parts and very long programs with thousands of
features. The basic premise of any temperature compensation is that the machine, the room, and
the part have settled to equilibrium. If there are large temperature swings (>+/-2° F), then the
temperature variation will have more of an effect than the compensation.
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Construction Defaults

Because Micro-Vu measurement systems are used to measure everything from precision ball
bearings and computer chips to rubber hoses and coat hangers, we have tried to make the software
powerful yet simple. The Construction Defaults give the operator a means to customize some of the
functionality. The distance between two circles can be the minimum, center-to-center, or maximum
distance. The same options are available for a circle to a line or a circle to a point. There are two
options for a line bisecting two lines, a line along the bisecting angle and its perpendicular.
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